
SwordSearcher Bible Software
Version 7.2

Copyright ©2015 StudyLamp Software LLC, all rights reserved.
SwordSearcher is a registered trademark.

PO Box 140478
Broken Arrow, OK 74014 USA

Website: http://www.swordsearcher.com
Email: bstaggs@swordsearcher.com

This manual can be accessed in help-file form from within the SwordSearcher
program by selecting Open Help from the Help menu.

Please note: Some items referred to in this manual apply only to the Deluxe
version of SwordSearcher. If you are using the evaluation download version, some
functions or resources (such as maps and images) will not be available to you until
you purchase the full Deluxe version. Please see the website for ordering
information.

The inclusion of material in the SwordSearcher Bible Software library is not an a
priori endorsement of that material. Commentaries and other books are the
writings of men and as such are prone to human error. Many of these materials
present differing positions on some doctrines. Always remember to compare any
statements of man against Scripture, as only Scripture is pure.



SwordSearcher 7I

© 2015 StudyLamp Software LLC

Table of Contents
Part I Quick-Start 1

................................................................................................................................... 11 How to Start Studying a Verse 

................................................................................................................................... 32 How to Search the Bible 

................................................................................................................................... 53 Using the Bible Margin Links 

Part II Main Window and Panels 10

................................................................................................................................... 101 The Bible Panel 

................................................................................................................................... 172 The Books & Dictionaries Panel 

................................................................................................................................... 213 The Commentary Panel 

................................................................................................................................... 234 The Search Results Panels 

.......................................................................................................................................................... 25Verse List (Bible Search Results) 

.......................................................................................................................................................... 27Verse Guide 

.......................................................................................................................................................... 30Library Search Results 

................................................................................................................................... 315 The Main Window Toolbar 

................................................................................................................................... 366 Zooming 

Part III Managing Library Tabs 38

Part IV Searching and Indexing 42

................................................................................................................................... 431 Search Bible Dialog 

.......................................................................................................................................................... 47Word List Dialog 

.......................................................................................................................................................... 48Proximity Search 

.......................................................................................................................................................... 50Character String Search 

.......................................................................................................................................................... 51Regular Expression Search 

................................................................................................................................... 532 Full Library Search Dialog 

................................................................................................................................... 553 Search KJV Words of Christ Dialog 

................................................................................................................................... 564 Advanced Search Expressions 

................................................................................................................................... 605 Topic and Verse Guide 

................................................................................................................................... 636 Module Selection Tool 

................................................................................................................................... 657 English-Strong's Indexer 

................................................................................................................................... 678 Library Table of Contents 

................................................................................................................................... 689 Find Related Verses 

................................................................................................................................... 7310 Bible Word Cloud Generator 

................................................................................................................................... 7611 Passage Analysis 

................................................................................................................................... 7812 Reference Pattern Search 

................................................................................................................................... 8013 The King James Version with Strong's Links 

................................................................................................................................... 8214 Scan Text for Verse References 

................................................................................................................................... 8515 StudyClick 



IIContents

II

© 2015 StudyLamp Software LLC

Part V Copying and Exporting Text 88

................................................................................................................................... 881 Configuring Verse Formatting 

................................................................................................................................... 902 Copying Verses to the Clipboard 

................................................................................................................................... 933 Automatically Pasting Verses into Other Applications 

................................................................................................................................... 934 Copying Book and Commentary Entries to the Clipboard 

................................................................................................................................... 935 Printing Verses 

................................................................................................................................... 936 Printing Book and Commentary Entries 

Part VI Module Sets 95

Part VII The Image Viewer 100

Part VIII Devotional Functions 102

Part IX Reading Schedules 103

................................................................................................................................... 1041 Creating a Reading Plan 

.......................................................................................................................................................... 107Designing Custom Reading Plans 

................................................................................................................................... 1142 The Reading Schedule Window 

................................................................................................................................... 1163 Reading Schedule Manager 

Part X Using Bookmarks 120

Part XI Creating Your Own Books and Commentaries 122

................................................................................................................................... 1251 Using the Editor 

.......................................................................................................................................................... 129Verse Links and Links to Other Resources in User Entries 

.......................................................................................................................................................... 133Bible Study and Sermon Preparation in User Books 

.......................................................................................................................................................... 133Using the Code Editor 

................................................................................................................................... 1352 User Module Storage and Sharing 

................................................................................................................................... 1363 Exporting and Printing User Content 

................................................................................................................................... 1374 Advanced User Module Maintenance 

................................................................................................................................... 1385 Importing Modules from Previous Versions 

................................................................................................................................... 1396 Building SwordSearcher Modules with Forge 

Part XII Preferences (Options and Settings) 140

................................................................................................................................... 1411 Fonts and Colors 

................................................................................................................................... 1412 Library Tabs Appearance 

................................................................................................................................... 1423 Visible Library Tabs 

................................................................................................................................... 1434 Bible Margin Links 

................................................................................................................................... 1435 Verse Widgets 

................................................................................................................................... 1446 Text Display Options 

................................................................................................................................... 1457 Misc. Options 

................................................................................................................................... 1488 Layout Options 



SwordSearcher 7III

© 2015 StudyLamp Software LLC

................................................................................................................................... 1489 Sync Options 

................................................................................................................................... 14910 StudyClick Options 

................................................................................................................................... 15111 Bible Book Abbreviations 

................................................................................................................................... 15112 Module File Locations 

Part XIII Panel Layout 153

................................................................................................................................... 1531 Using the pre-set layout styles 

................................................................................................................................... 1552 Resizing, Maximizing, and Hiding the panels 

................................................................................................................................... 1553 Advanced: Customizing the layout 

................................................................................................................................... 1594 Even more advanced: Auto Hide 

Part XIV Clone Panels 161

Part XV Bible Audio Support 163

Part XVI Appendix: Keyboard Shortcuts 170

Part XVII Appendix: Standard Bible Book Abbreviations 173

Part XVIII Appendix: SwordSearcher URL Protocol 174

Index 176



Quick-Start 1

© 2015 StudyLamp Software LLC

1 Quick-Start

Here are some quick-start guides to help you jump right in to SwordSearcher.

· How to Start Studying a Verse
· How to Search the Bible
· Using the Bible Margin Links

Some other important SwordSearcher concepts are:

· Library Tabs  (how to show or hide them)
· Main Window and Panels

Finally, several instructional videos can be viewed on the SwordSearcher web
site. See http://www.swordsearcher.com/video.

1.1 How to Start Studying a Verse

There are many ways of studying a passage in SwordSearcher. For this quick how-to,
we'll examine doing so by just typing in a verse reference.

To start studying a verse and see what details the library has to offer, click the Go To
Verse and Search toolbar text area (or press F6) and enter a verse reference:

This is a sample image of the Go To Verse and Search
box from the SwordSearcher main window.

For this example, we'll type 2Ti 3:16. SwordSearcher understands many different ways

of specifying a verse. We could  just as easily type 2nd Timothy 3.16, or even 2Tim iii.

16. Use what works best for you. After pressing the Enter key, three things happen right

away:

1. The Bible panel is set to 2nd Timothy, chapter 3, verse 16:

1

3

5

38
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http://www.swordsearcher.com/video
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This is a sample image of the Bible panel from the SwordSearcher main window, set to 2nd
Timothy 3:16.

2. A Verse Guide is opened for the same verse:

This is a sample image of a Verse Guide for our selected verse.

3. Finally, the Commentary panel is also set to the selected verse:
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This is a sample image of the Commentary panel from the SwordSearcher main window, set to our verse.

As you can see, the Go To Verse and Search toolbar is a great way to start studying a
verse. There are many other ways to navigate to a verse, of course. Explore
SwordSearcher for more!

Related topics:
The Go To Verse and Search toolbar
The Bible Panel
The Verse Guide Panel

1.2 How to Search the Bible

Next we'll examine a quick way to search the Bible for some words.

To enter the words you want to search for, click the click the Go To Verse and Search
toolbar text area (or press F6) and type a word or words:

This is a sample image of the Go To Verse and Search box from
the SwordSearcher main window.

32

10

27
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For this example, we'll look for sword spirit, which will find verses that have both the

words sword and spirit. After typing the words and pressing Enter, all of the verses in the
active Bible text matching our search are loaded in a Verse List panel, which appears
below the Bible panel like this:

This is a sample image of a Verse List panel showing the results of our search.

As you can see, the words we searched for are highlighted. From a Verse List panel there
are numerous things we could do to continue our study, such as opening a Verse Guide
panel for one of the verses, viewing commentary links for the verses, etc.

(If you want to do an exact phrase search, place the words in quotes, like "love of God"

.)

If we hold the mouse pointer over a verse link in the Verse List, a preview of the context
is shown. If needed, the link can be clicked to examine the entire chapter in the Bible
panel.
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Sample of verse pop-up context preview in Verse List panel.

The Quick Bible Search toolbar is a fast way to find verses with words you have in mind.
SwordSearcher supports a lot more than just simple word searching, too: if you need
more control over the search, you can use the Search Bible dialog , or use Advanced
Search Expressions .

Related topics:
The Go To Verse and Search Toolbar
The Search Bible dialog
Verse List Panels
Advanced Search Expressions

1.3 Using the Bible Margin Links

Note: the amount of information the Bible Margin Links give you depends on how many library modules you
have installed in SwordSearcher.  The evaluation download version of SwordSearcher only includes a few of
the library modules from the full, Deluxe version.

The Bible panel can show links in the right margin making it easy to quickly access
material related to the displayed verses. This is called the margin area and the links are
called margin links.

43
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This is a sample image of the Bible panel from the SwordSearcher main window.

These links can easily be turned off if you do not need them with the toolbar buttons,
and you can also control  which library modules are included in the margin area.

Using margin links for commentaries is simple: click the link to load the comment text in
the Commentary Panel. Comment links are only shown when the commentary has a
comment text specifically on the verse. (The Verse Guide  can be used to find
comments that only reference the verse.)

Margin links for books will appear whenever a book has an entry that references the
verse. For example, clicking the Chain link for John 1:9...

143

27
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Sample image showing the mouse cursor
over the Thompson Chain Reference

(Chain) link for John 1:9

...will show each entry in the Thompson Chain Reference that includes a reference to
John 1:9:

Sample reference index for
Thompson Chain Topics on

John 1:9

Clicking on an entry title, such as "Christ" in the above sample, would load that entry in
the Book panel with the reference highlighted.

Choosing what appears in the Margin Area

As you become familiar with your SwordSearcher library, you will probably want to be
selective about which items appear in the margin area. You can select which library
modules (books and commentaries) appear in the margin area very easily.

Right-click on the margin toggle button and choose "Select items for Bible margin
links...":
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Sample showing how to select Bible Margin items

The Bible Margin Links section of Preferences will appear:

Bible Margin Links section of SwordSearcher Preferences

You can quickly check and un-check items to choose what appears in the Bible margin.

Related topics:
The Bible panel
Preferences: Verse Widgets
Preferences: Bible margin link selection

10

143

143
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The Book panel
The Commentary panel
Verse Guide Panels

17
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2 Main Window and Panels

SwordSearcher's Main Window is designed with four "study panels:" A Bible panel, a
Book & Dictionary panel, a Commentary panel, and a Search Results panel.

Sample of SwordSearcher Main Window

You can choose between several different pre-set layouts to change the position of the
panels, or you can customize the layout to your specific tastes.

The main window also has several toolbars used to access commonly used features of the
software.

For details, see:
The Bible Panel
The Books & Dictionaries Panel
The Commentary Panel
The Search Results Panels
The Main Window Toolbar

To learn how to change the layout of the panels, see Panel Layout .

You can create temporary "copies" of the Bible, Book, and Commentary panels, called 
Clone Panels .

2.1 The Bible Panel

The Bible panel is where you will do most of your Bible reading. This is where
SwordSearcher displays Bible text, as well as (optionally) links to related material.

10
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Sample Bible panel

The tabs in the Bible panel switch between Bible texts. The tabs have abbreviations for
Bible texts (e.g. 'KJV' for the King James Version), and holding your mouse pointer over
a tab for a moment will display the full title of the Bible text. (Another way to access
Bible texts is from the main menu under Bible > Select Bible.) You can control which tabs
are visible for your library items; see Managing Library Tabs .

The Bible panel's margin area includes footnotes for the Bible text and links to material
related to the verse. In addition to controlling what type of links are shown with the
toggles described below, you can use the Margin Links  section in Preferences to
specify which library items should be included in the margin area. (You can also use a 
Module Set  to control which items are included in the margin area.)

Verse Widgets appear under each verse reference in the Bible panel, giving one-click
access to various verse-related functions and to your favorite commentaries. See
configuring Verse Widgets  for more information.

If you have configured Bible audio support , familiar audio controls are shown at the
bottom of the Bible panel:

38
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Sample audio control bar, which appears if Bible audio support has been configured (optional).

The Bible panel has its own toolbar for quick access to various features specific to the
Bible panel.

Sample Bible panel toolbar

Back/Forward: Go back to a previous passage you were viewing as well as return. Right-
click the forward or back buttons for a history list.

Book and Chapter Selection: This is one way to select a book and chapter to view. You
can also use the Go To Verse toolbar  to type in a verse reference.

Previous/Next Chapter: You can quickly move back or forward by one chapter with these
buttons.

Margin Area Display Toggle: When selected, the margin area will be displayed in the
Bible text area, depending on which items you have selected (commentary links, book
links, footnotes, and edit links; see following). You can also right-click this button to
configure which items are included in the margin area.

Footnotes Display Toggle: When selected, footnotes for Bible text (if available) will be
included in the margin area.

Commentary Links Toggle: When selected, links to commentary text on the verse (if
available) will be displayed in the margin area.

Book Links Toggle: When selected, links to Book and Dictionary entries that reference the
verse will be displayed in the margin area.

Edit User Commentary Links Toggle: When selected, and a user commentary has been
created, links to edit the commentary on that verse will be displayed in the margin area.

Paragraph Mode Toggle: When selected, Bible text will be formatted in paragraph style.
Note: When paragraph mode is selected, the margin area is not displayed.

Compare Mode Toggle: When selected, a second column of Bible text is shown for the
selected compare version. Right-click the compare mode toggle button to select the

32
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compare version. Note: the compare column is not shown if the currently selected Bible
version tab is the same as the specified compare version.

Highlighting and Underlining: Apply markup (colored highlighting and/or underlining) to
text you have selected with the mouse, or to clear markup you have applied.

Bible Word Cloud Generator: Opens the Bible Word Cloud Generator , set to the current
chapter.

Quick Topical Lookup:

Double-clicking a word in the Bible panel will attempt to look up that word in the Topic
Guide . You can customize or disable this behavior to your liking in the Sync Options

.

You can also use the Webster's 1828 Dictionary lookup feature on the pop-up menu,
shown below. (Requires Deluxe version.)

StudyClick:

Hold down the CTRL key as you move the mouse pointer over words to turn them into
links for instant StudyClick actions. See StudyClick .

The Bible Panel Pop-up Menu

Right-click a verse in the Bible panel to activate the Bible panel pop-up menu.

73
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Sample Bible panel pop-up menu

Most of these functions are self-explanatory. Notice also that several of these functions
have short-cut keys associated with them. Several pop-up menu features simply
duplicate functions found on the toolbars or main menu. A few details will be beneficial:

Whenever a function refers to Selected Text, it is referring to any text you might have
marked with your mouse in the Bible panel before right-clicking. If you have not selected
any text with your mouse, these functions will not apply.

Copy 2Ti 3:16: When you right-click on a verse, this option will reflect the verse you click
on. This function quickly copies the verse to the clipboard according to your Export
Formatting options . Using this function alleviates the need for manually selecting the
text of the verse to copy and allows you to decide how you want the text copied via the
Export Formatting options.

Copy 2Ti 3:16 through verse >: Like the above function, this reflects the verse you
clicked on. This function differs from the previous in that it allows you to select a verse to

88
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copy through (a range of verses in the chapter rather than just one verse).

Open English-Strong's Indexer for... Whenever you right-click a word in the Bible display
that exists in the KJV, you can use this function to open the English-Strong's Indexer for
that word automatically. For more information, see Using the English-Strong's Indexer
.

Webster's Definition for... If you have the Webster's 1828 Dictionary module installed,
and the word you right-clicked on appears in it, this item will quickly load that definition
in the Book and Dictionary panel.

Panel and Margin Configuration contains the same toggle options from the Bible panel
toolbar and shortcuts to configuring verse widgets .

Clone Panel creates a new panel with a copy of the current content. See Clone Panels
for more information.

Setting a Compare Version

You can compare two Bible versions by setting a compare version. Right-click the
compare mode toggle button to select a comparison text. Left-clicking the toggle will
switch on or off the comparison column.  You can also right-click one of the Bible tabs
and select the "Show as compare version" item.

The compare version will be displayed to the right of your primary version. (The tab you
have selected for the Bible text is your primary version.) Note that you may select the
same version for compare and primary, but when you do so, you will only see a single
Bible column. The reason for this is that when you change your primary version, the
compare version stays the same. For example, if you select KJV as your compare version,
then whenever you select a different primary version, the KJV text will display to the
right of it.

Below is an example of a Bible panel with the primary version set to the Textus Receptus
and the compare version set to the King James Version.

65
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Sample Bible panel showing compare mode

Highlighting and Underlining

You can personalize Bible text in the Bible panel with user markup (highlighting and
underlining). Select words with the mouse by clicking and dragging over the words. Use
the Highlighting and Underlining button on the toolbar to apply markup:

Sample showing markup actions

The main Bible menu contains functions for managing user markup:
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Sample Bible menu

Disable Allow User Highlighting and Underlining if you have no need for user markup and
want to disable the highlighting and underlining features of the Bible panel.

Show Verses with User Highlighting or Underlining shows you all the verses you have
applied markup to, and also provides an easy way to quickly remove highlighting from a
group of verses or the entire Bible text.

After selecting text with the mouse, you can press Ctrl+H to apply highlighting using the
most recent color or underline you have used.

New Testament-only Bible texts

Some Bible texts in SwordSearcher are only New Testament texts. If you are reading or
comparing an Old Testament passage and have one of these modules selected, no text
for the verses will be shown because none is available.

King James Version with Strong's Links

A special Bible text in SwordSearcher is the KJVSL, or King James Version with Strong's
Links. For an explanation of what the KJVSL is and the features it adds to the Bible panel,
see Using the King James Version with Strong's Links .

2.2 The Books & Dictionaries Panel

The Books and Dictionaries panel (usually referred to simply as the Book panel) is for
library modules that are not Bibles or verse-by-verse commentaries. This is where you
will find dictionaries, encyclopedias, topical references, and books. Note that if you do

80
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not have any book modules installed and you have not created a user book module this
panel will be hidden.

Sample Books and Dictionaries panel

The tabs in the Book panel select which book to view. The tabs display abbreviations (e.
g. "Chain" for Thompson Chain Topics), and holding the mouse pointer over a tab for a
moment will display the full name of the book. (Another way to access books is from the
main menu under Books > Select Book.) You can control which tabs are visible for your
library items; see Managing Library Tabs .

As in this example, most books have links to verses. You can move the Bible panel to a
linked verse by clicking on it. Or for a quick view of the verse linked, hold the mouse
pointer over the link to see the verse in a pop-up display.

A special color will be used to paint the tabs for other Books that have a matching entry
.  In the above example, the Chain, ISBE, masCyc, and Watson tabs are highlighted
because they also have an entry for "Scripture," the current entry in the active book
Morrish.  This is a quick visual way to see which books have similar material. A more in-
depth way to see this is to click the Open Topic Guide button (shown below), which will
include books that do not currently have visible tabs.

The Book panel has its own toolbar for quick access to functions specific to the Book
panel.

38
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Sample Books and Dictionaries panel toolbar

Back/Forward: Go back to a previous passage you were viewing as well as return.

Book Entry Selection: Here you can select an entry for the book. You can begin typing
the entry you are looking for, or use the drop-down selector to view the available entries.

Previous/Next Entry: Moves to the previous or next entry in the book.

Open Topic Guide: Opens the Topic Guide and searches for the active entry title. This is
especially useful with dictionaries and topical guides, allowing you to easily view a list of
books with entries that have the same and similar titles.

Verse List: (Load all Referenced Verses) If there are verse references in the current
entry, this loads all of them at once into a Verse List Panel.

Quick Search Book: Provides a fast way to search for a word or phrase in the active Book.

Edit, New, Rename, and Delete Entry: These items are active only for user-created
books, and are for creating and editing entries in your own books.

StudyClick:

Hold down the CTRL key as you move the mouse pointer over words to turn them into
links for instant StudyClick actions. See StudyClick .

The Book Panel Pop-up Menu

Right-click in the Book panel text display area for the Book panel pop-up menu.

85
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Sample Books and Dictionaries pop-up menu

Most of these functions are self-explanatory. When a function refers to Selected Text it is
referring to any text you may have marked in the Book panel with the mouse before
right-clicking. If you have not selected any text, these functions will not apply.

Load All Referenced Verses: This function loads all of the referenced verses in the current
entry in a Verse List panel .

Table of Contents Tool: A shortcut to opening the Table of Contents Tool  with the
current Book entry pre-selected. An alternative to using the entry selector.

If you right-click a verse link, you can select Copy Verse(s) From This Link to copy the
linked verses to the clipboard without needing to view them in the Bible or Verse List
displays.

Clone Panel creates a new panel with a copy of the current content. See Clone Panels
for more information. Also, you may Ctrl+Click a verse link to open the linked reference
in a new clone Bible panel.

25
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2.3 The Commentary Panel

The Commentary panel is for library modules that are classified as commentaries, with
entries tied to specific verses. Note that if you do not have any commentary modules
installed and you have not created a user commentary module, this display will be
hidden.

Sample Commentary panel

The tabs in the Commentary panel select which commentary to view. The tabs display
abbreviations (e.g. 'TSK' for the Treasury of Scripture Knowledge), and holding the
mouse pointer over a tab for a moment will display the full name of the commentary.
(Another way to access commentaries is from the main menu under Commentary >
Select Commentary.) You can control which tabs are visible for your library items; see
Managing Library Tabs .

As in this example, most commentaries have links to verses. You can move the Bible
panel to a linked verse by clicking on it. Or for a quick view of the verse linked, hold the
mouse pointer over the link to see the verse in a pop-up display.

A special color will be used to paint the tabs for other commentaries that have a
matching entry.  For example, if you have the TSK active, and are reading the entry on
2Ti 3:16, other commentaries (such as Barnes, Clarke, Pulpit, etc.) that have an entry on
the same verse will have their tab specially colored as in the above sample.  This is a
quick visual way to see which commentaries have related material.

38
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Sample Commentary panel toolbar

Back/Forward: Go back to a previous passage you were viewing as well as return.

Commentary Entry Selection: Here you can type in a verse reference to view the active
commentary's text on that verse (if any), or use the pull-down selector to select an
available entry. You can type a verse range if you want to read more than one
commentary entry at a time, up to a full chapter. For example, Type "Ge 1" to view all of
the comments on Genesis chapter 1 in the panel.

Previous/Next Entry: Moves to the previous or next entry in the commentary. Note that
this does not always move one verse at a time, since commentaries do not always have
text on every verse.

Expand to Chapter: Shows all of the entries in this commentary for the current chapter at
once. Essentially, all of the commentary text pertaining to the current chapter is visible
at once.

Verse List: (Load all Referenced Verses) If there are verse references in the current
entry, this loads all of them at once into a Verse List Panel.

Open Topic Guide: Opens a Topic Guide  set to the verse shown in the active
commentary.

Quick Search Commentary: Provides a fast way to search for a word or phrase in the
active commentary.

Delete, Edit Entry: These items are only active for user-created commentaries, and are
for editing or deleting commentary text.

StudyClick:

Hold down the CTRL key as you move the mouse pointer over words to turn them into
links for instant StudyClick actions. See StudyClick .

The Commentary Panel Pop-up Menu

Right-click in the Commentary panel text display area for the Commentary panel pop-up
menu.

60
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Sample Commentary panel pop-up menu

Most of these functions are self-explanatory. When a function refers to Selected Text it is
referring to any text you may have marked in the Commentary panel with the mouse
before right-clicking. If you have not selected any text, these functions will not apply.

Load All Referenced Verses: This function loads all of the referenced verses in the current
entry in a Verse List panel .

If you right-click a verse link, you can select Copy Verse(s) From This Link to copy the
linked verses to the clipboard without needing to load them in the Bible or Verse List
panels.

Clone Panel creates a new panel with a copy of the current content. See Clone Panels
for more information. Also, you may Ctrl+Click a verse link to open the linked reference
in a new clone Bible panel.

2.4 The Search Results Panels

During the course of study with SwordSearcher, various search results will be displayed.
There are three different kinds of search result panels, and with the default layout, they
appear as tabs after more than one search results panel has been created.

25
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When you first start SwordSearcher, the search results panel area is either hidden or
empty, like this:

Search results panel area before any searches have been performed

After you perform searches or certain other functions, the results panel may look
something like this:

Sample result panels, showing a verse list from a Bible search
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When more than one search result panel is available, you will use the tabs at the base of
the search results to switch between them. Notice also that the tabs have close buttons.
These buttons affect the specific panel they are on, so clicking the close button on the
tab above that says "KJV Search: scripture" would only close that particular result
display.

If you have several result panels open, you may find using the tabs menu button an
easier way to switch between them, like this:

The View menu on the main menu bar also has several items for navigating search result
panels.

If you do not wish a new Verse Lists or Library Search panels to be created for every
search, you can select the appropriate re-use panel option in Layout Preferences .
With Re-use Verse List Panels selected, only one Verse List panel would be created, and
each search would replace the contents on the panel.

See the following help topics for details on the different types of search result panels:

Verse List (Bible Search Results)
Verse Guide
Library Search Results

2.4.1 Verse List (Bible Search Results)

A Verse List panel is a search result panel created when you do one of the following:

· Perform a Bible search (either with the Search Toolbar  or the Search Bible dialog
).

· Use the Load All Referenced Verses command on the Book or Commentary panel pop-
up menus.

· Use the Display Verses command on the Search menu.

148
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Sample Verse List panel, after doing a Bible search in the KJV for "sword."

A Verse List panel is very similar to the Bible panel , with the primary difference being
that a Verse List panel does not show Bible verses by chapter, but shows only lists of
verses. The reference of each verse is shown as a link, which sets the Bible panel to the
verse when clicked.

The Bible version selector changes the Bible version used to display the verse list. Note
that if the verse list is displaying search results, changing the version does not perform
the search again on the new version, but allows you to see how the verses appear in the
newly selected version. Therefore, when switching versions in this manner, the verses
displayed may not actually contain the words used in the search. You may also use the 
compare column, which is usually more convenient when you need to compare
differences.

The Results Page Selector switches between the pages of the verse list, which are divided
into pages of 100 verses each when there are more than 100 verses in the list. The page
selector shows the range of verses displayed on each page of the verse list.

Like a Bible panel, a Verse List panel can display a margin area with links to related
library material. Use the footnotes, commentary links, book links, and edit user
commentary links toggles to configure the margin area if you wish to have it displayed.
The compare column toggle button toggles the display of the compare version column.
Right-click the compare toggle button to select the compare version. (The compare
column will only appear if the compare version is different from the selected version.)
The Verse List Defaults section in Preferences  controls how a Verse List margin area (if
any) and compare column will appear when the Verse List panel is created.
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Copy All Verses From List will copy the entire verse list to the clipboard according to
your Export Formatting options .

Copy All Verse References From List will copy a list of references, without the verse text,
to the clipboard.

The Verse List panel pop-up menu is similar to the Bible panel pop-up menu . Access
the pop-up menu by right-clicking a verse or word in the text display area.

The Search Info and Stats button applies for Bible search results only, and opens an
information window showing details about the search, including a "result map" with links
to the first match of each verse, and bar graphs showing statistical information.

Bible Word Cloud Generator: Opens the Bible Word Cloud Generator , and builds a
word cloud based on the verses in the Verse List. This can be a very illuminating way to
visualize other words commonly associated with your search words.

A note about match counts: When you do a Bible search, the Verse List will show how
many matches as well as how many verses are in the results. The match count works
well and is useful for simple word or phrase searches. However, be aware that the match
count loses its meaning for complex boolean searches when different parts of the search
can match the same word in a verse. The match count is a tally of how many portions of
the text are highlighted to show the results.

StudyClick:

Hold down the CTRL key as you move the mouse pointer over words to turn them into
links for instant StudyClick actions. See StudyClick .

2.4.2 Verse Guide

A Verse Guide panel is a type of search result panel created when you do one of the
following:

· Type a verse reference in the Go to Verse toolbar , or, using the set active verse
Verse Widget .

· Use the Verse Guide item on the Bible panel  pop-up menu.

A Verse Guide shows you all of the library material that references a particular verse or
passage. Clicking on an item will load it in the appropriate panel, with the verse
reference highlighted. As an example, the following Verse Guide is displayed when you
type 2Ti 3:16,17 into the Go to Verse toolbar and press Enter.

88

13

73

85

32

143

10



SwordSearcher 728

© 2015 StudyLamp Software LLC

Sample Verse Guide for 2Ti 3:16,17

The first section of the Verse Guide shows commentaries that have entries specifically on
the verse(s):

Sample Verse Guide, showing commentaries on verses

The second section shows commentary entries that reference the verse(s):
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Sample Verse Guide, shoing commentaries referencing verses

The remainder of the verse guide shows Book and Dictionary entries that reference the
verse(s).

Sample Verse Guide, showing multiple Books with entries titled INSPIRATION referencing 2Ti
3:16-17

The above example shows book results sorted by entry title, where same-title entries
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from books are grouped together (as in INSPIRATION in the above example).

You can click the settings button and change the sorting to group entries by book:

Verse Guide Panel settings menu

With entries sorted by book, the Verse Guide looks like this:

Sample Verse Guide, showing book entries grouped by book module, for 2Ti 3:16-17.

2.4.3 Library Search Results

A Library Search Results panel is created when you do one of the following:

· Use the Full Library Search dialog .
· Use the Quick Search in Active Book function on the Search menu or Book panel

toolbar.
· Use the Quick Search in Active Commentary function on the Search menu or

commentary panel toolbar.

A Library Search Results panel displays a preview of library items from the search.

53
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Library Search Results panel showing results from a full library search for INSPIRATION

The above example shows the result of a full library search. Use the Library Resource
Selection tree on the left to view the results of various library modules, which are
displayed in the text area on the right. The Results Page Selector switches between
pages of results for the selected library resource when there are more than 100 matching
entries.

Clicking a link to an entry, such a GENESIS above, would open that entry in the
appropriate panel. Hint: After you click on a link to an entry, the text loaded in the
appropriate panel will have the search word(s) highlighted. If you click on that panel
(Bible, Book, or Commentary) with search results highlighted, you can then press the +
and - (plus and minus) keys to "cycle" through all of the highlighted words, scrolling
them into view.

When a search results in only a single library resource having matching entries, such as
when you do a Quick Search in Active Book or Commentary, the library resource
selection tree on the left will be hidden.

2.5 The Main Window Toolbar

SwordSearcher's Main Window Toolbar provides quick access to several often-used
functions.

Sample of SwordSearcher's Main Toolbar Area

You can reorganize the toolbars by click-dragging the grips on the left of each toolbar.
You can toggle the display of each toolbar with the Toolbars submenu on the View main
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menu.

Go To Verse and Search Toolbar

Go to Verse and Search toolbar

The Go to Verse and Search toolbar is the fastest way to start studying a verse or
perform a Bible search, and can also be used to open other search and visualization
tools, or to open library modules.

To start studying a verse:

Click the text area (or press F6), then type a verse reference and press Enter. The Bible
panel  will go to the specified verse; the Commentary panel  will open the text for
the specified verse in the active commentary; and a Verse Guide  will be opened for
the specified verse(s). You can disable the commentary and verse guide synchronization
in Preferences: Sync Options .

Specify a verse by typing the first two or three letters of the book name. For books with
numbers, use a digit like this: 2Ti 3:16 (for Second Timothy, chapter 3, verse 16). You

can use a period instead of a semicolon for faster typing.

Here are some examples of valid verse references:
Ge 1.1 (for Genesis 1:1)

2Ti 3.16-17 (for Second Timothy, chapter 3, verses 16 and 17)

Ro 1 (for Romans chapter 1)

See Bible Book Abbreviations  for SwordSearcher's standard Bible book abbreviations.
SwordSearcher understands over 2,000 variations of Bible book abbreviations. When in
doubt, just spell out the first few letters of a book name.

When you specify a range of more than one verse, such as a chapter, the Bible and
Commentary panels are set to the first verse of the range, and the Verse Guide opens for
the entire range (to a maximum of a full chapter).

To perform a Bible search:

Click the text area (or press F6) and type a word or words to search for and press Enter.
A Verse List  will be loaded with all of the verses matching your search using the Bible
text that is currently active in the Bible panel .

While you will normally just type a word to search for, the search box also fully supports
SwordSearcher's advanced search expression syntax  (see for details).

Entering multiple words will find verses that contain all of the words. You can search for
a phrase by enclosing the words in quotes, like "jesus christ". For more advanced
searching capability, use the Search Bible dialog  or advanced expressions .

The search toolbar will also suggest alternate words if you enter a word and it is not
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found in the active Bible text. For example, entering "color" in the search  box when the
KJV is active will bring up this dialog:

Word suggestion for "color" in the KJV

This is because color is spelled colour in the KJV, which uses British spelling. The
suggestion dialog presents the most likely matching words. This feature works well any
time you use an American spelling of words like savior, color, favor, etc., and is
remarkably effective in correcting spelling errors. When this dialog appears, you can
immediately press Enter to search the most likely word, or Esc to cancel.

For a more advanced word lookup tool, see the Word List feature  of the Search Bible
dialog.

Additional uses of the Go to Verse and Search toolbar

As you type in the search box, a suggestion menu will appear below the entry area. The
most useful aspect of the suggestion box is predictive phrase suggestion. For
example, if you start typing "God love" the following suggestions will appear:

47
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Sample suggestion list for search

Search suggestions will update immediately as you type, and you can use the down
arrow key or mouse to select an option.

The Go To Verse and Search box can also be used to locate library modules, load a verse
list (enter multiple references), open a topic guide, and start other tools in
SwordSearcher.

Tip: You can "drag" selected text into the Go To Verse and Search box from another
application (or from inside of SwordSearcher) and the text will be analyzed and an
appropriate action taken, such as performing a Bible search or setting the current active
verse.

Copy Tools Toolbar
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The Copy Tools Toolbar

Copy Selected Text: Copies selected text to the clipboard.

Copy Some Verses: Opens the Copy Verses dialog, for copying verses to the Windows
clipboard.

Search Tools Toolbar

Search Tools Toolbar

Search Bible: Opens the advanced Search Bible dialog .

Full Library Search: Opens the Full Library Search dialog , for searching the contents of
the entire library at once.

Open Topic Guide: Opens the Topic and Verse Guide , a mega-index of all of the library
modules.

Open English-Strong's Indexer: Opens the English-Strong's Indexer , similar to Young's
Analytical Concordance.

Open Scan Text for Verse References tool: Opens the Scan Text for Verse References tool
, which hot-links verse references in any text you provide, such as a document from a

web page.

Tip: You can "drag" selected text into one of the above buttons from another application
(or from inside of SwordSearcher). For example, you can drag text into the Search Bible
button to pre-fill the search text, or drag a paragraph of text from a web browser to the
Scan Text for Verse References button to see all of the verses referenced in the text.

Reading Schedule Toolbar
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Reading Schedule Toolbar

Open Reading Schedule: Opens the daily Reading Schedule  window. The Schedule
Status Indicator lets you see at a glance the current state of your reading schedule
(whether you are behind or up-to-date), if any.

Layout and Tabs Tools Toolbar

Layout and Tabs Tools Toolbar

Restore Last Set Layout positions and sizes the display panels (Bible, Book, etc)
according to the last  layout  used ("Bible on Left" by default). The Layout Selection
Menu selects which layout style to use, or saves and loads custom layouts. See Panel
Layout .

Library Tabs Visibility opens the Visible Library Tabs page of Preferences , where you
can select which library modules have visible tabs in the Bible, Book, and Commentary
panels. Use this to switch off library modules you rarely use in order to reduce screen
clutter. See Managing Library Tabs .

2.6 Zooming

The bottom-left of the main window has a zoom control:

Zoom button on main window

Click the zoom button to toggle between zoom levels.  The zoom menu can be used to
select among specific zoom levels.
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The keyboard shortcuts CTRL++ and CTRL+- can also be used to cycle the zoom setting.
Press CTRL+Alt+0 to reset to 100%.

Zooming affects the Bible, Verse List, Book, and Commentary Panels, and the English-
Strong's Indexer.

Using the mouse wheel: To temporarily zoom a specific panel in our out, hold down
CTRL and roll the mouse wheel over the panel text. The zoom level for this panel will
automatically reset the next time the content of the panel changes.

Using touch input: The "pinch to zoom" touch gesture can also be used to temporarily
zoom in or out in a panel if you have a display that supports touch input.

Also see Fonts and Colors  if you wish to simply change the font size.141
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3 Managing Library Tabs

Library tabs are the graphical controls used in SwordSearcher to represent the various
library items (called modules) in the program, such as the KJV, Easton, Torrey, etc. They
appear at the top of the Bible , Book , and  Commentary  panels.

Sample of Bible library tabs

Using these tabs is fairly straightforward.  Click KJV to bring the KJV Bible text into view.
To switch to the KJVSL, click KJVSL, etc. You can also use the Bible, Book, and
Commentary menus to select library modules.

Library module tabs also have their own right-click menus with some self-explanatory
options.

A Few Points About Library Tabs

Holding the mouse pointer over a tab for a moment, such as KJV, will show the full name
of the resource, such as King James Version. Right-click a tab and select "[Tab] Module
Information" to view publication and/or copyright details for the module.

To configure the appearance of the tabs (shape, color, font, alignment), see the Library
Tabs Appearance Preferences . If tabs take up too much space on your screen, be sure
to review Hiding Tabs (below), or change the tab display structure to single row in the
Library Tabs Appearance Preferences.

Opening Tabs that Aren't Visible

You can use the "Select Library Module" function on the File menu to open any library
module, including modules with hidden tabs. 

Or, you can use the handy drop-down list next to the tabs:

10 17 21
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Tabs drop-down list

The drop-down list of library modules can be filtered with keyboard input. For example,
start typing "Os" to quickly go to the Osborn Biblical History book in the list. If you want
the list to be limited to modules with open (visible) tabs, check the Only show items with
currently open tabs option. 

In the Book and Commentary lists, a "round i" icon signifies that there is a corresponding
entry for the module. This makes it easy to scan the list of modules to find ones that
have an entry with the same title as the one you are currently viewing (e.g., Scripture).

Hiding and Showing Tabs

You can hide library tabs for which you have no interest. Also, the first time you run
SwordSearcher, many of the tabs are automatically hidden so as not to overload your
display with tabs. Even when a library tab is hidden you can still open the module
by going to File > Select Library Module.

To set up which tabs are always visible, configure Visible Library Tabs .  This is how
you tell SwordSearcher which tabs you always want to see. To do so, click Select Tabs to
Show on the Tabs menu or click the library tabs button on the layout toolbar .  You
may configure visible library tabs to suit your own study needs.
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Sample Tabs Menu Sample Tabs Toolbar Button

Sample showing the Visible Library Tabs section of Preferences.

Once you have configured your Visible Library Tabs preference, you can use the Tabs
menu to apply the settings at any given time. Select Show All Tabs from the Tabs menu
(or press Alt+F11) to make all tabs visible (ignoring your Visible Library Tabs
preferences). This function is disabled if all tabs are already visible.  Select Show Only
Selected Tabs from the Tabs menu (or press Alt+F12) to hide all of the tabs that you
have not selected.  This function is disabled if you are already viewing only your
preferred tabs.

If you select, for example, the TR Bible module from the Bible menu (Bible > Select Bible
), but the tab is hidden, the tab for the TR module will be "unhidden" at that point to
make the text visible.  When you are ready to hide the TR tab again, select Show Only
Selected Tabs from the Tabs main menu again (or press Alt+F12).
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Please note that hidden library tabs do not mean that the library module is unavailable.
At any time you can see all of the installed library modules by selecting File > Select
Library Module, or the Select function on the Bible, Book, or Commentary menus.

The Module Selection Tool  can also be used to toggle tab visibility.

Using Module Sets to Control Tabs

You can set up custom Module Sets to switch between different preferred groups of
visible tabs. See the section on Module Sets  for more information.
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4 Searching and Indexing

Quick Search Functions

You can quickly perform a Bible search with the Go to Verse and Search Toolbar .

You can quickly search the active Book  with Quick Search in Active Book on the
Search Menu or Book panel toolbar.

You can quickly search the active Commentary  with Quick Search in Active
Commentary on the Search Menu or Commentary panel toolbar.

You can search the text displayed in a panel without searching the entire module with 
Find in Focused Panel Text on the Search Menu.

More Detailed Search Functions

The Search Bible dialog  provides you with all of the tools and control you need to
search Bible text. It can even help you search for words you're not sure know how to
spell , or find words near each other but not in the same verse .

The Full Library Search dialog  searches all or part of the entire SwordSearcher library
at once, including Bibles, Books & Dictionaries, and Commentaries.

The Search KJV Words of Christ dialog  does a Bible search restricted to the "red letter"
words (KJV Bible module only).

The Find Related Verses dialog  helps you to delve into a verse or passage, seeing how
its words are used throughout the Bible.

The Bible Word Cloud Generator  is a compelling visual tool that can help you see
words emphasized in a particular portion of Scripture.

Passage Analysis  gives you details on any portion of Scripture you choose (such as the
Old Testament or Pauline Epistles), including number verses, number of words, most
frequent words, most unique words, etc.

The Reference Pattern Search dialog  shows you verses matching patterns like "every
10th verse of a chapter."

If you need even more searching power, the Quick Bible Search toolbar, Search Bible
dialog, Search Words of Christ dialog, and Full Library Search all support
SwordSearcher's Advanced Search Expression Syntax .

Indexing Tools

A Verse Guide panel  shows you all of the library material that references a particular
verse or passage. It's a great way to conduct a verse-centric study and still be able to
access topical information as well as cross-referenced material. You can open a Verse
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Guide panel with the Go to Verse and Search Toolbar  or by right-clicking a verse in
the Bible panel and selecting Verse Guide.

The Topic and Verse Guide  includes the functionality of a Verse Guide panel and adds
the ability to create a dynamic index of all Books and Dictionaries for a given topic.

The English-Strong's Indexer  is a word-study tool that works much like the Young's
Analytical Concordance.

The Library Table of Contents  is a central location to view the entire installed library
index.

Displaying Verse References

Select Display Verses on the Search menu to open and load a Verse List with one or more
verse references.

The Scan Text for Verse References tool  hot-links verse references in any text you
provide, such as a document from a web page. It can also be used to load a longer list of
verse reference into a Verse List.

Strong's Numbers

The King James Version with Strong's Links  is a special Bible module in
SwordSearcher that includes links to Strong's definitions of Hebrew and Greek words in
the text. The KJVSL is searchable by Strong's numbers as well.

4.1 Search Bible Dialog

To open the Search Bible dialog, select Search Bible from the Search menu, or press F2,
or click the Search Bible button on the Search tools toolbar .

Note that if all you want to do is search for a few words, you may wish to use the Go to
Verse and Search Toolbar  on the main window instead.

This is what the Search Bible dialog looks like:
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Sample Search Bible dialog with Normal Search visible

There are several search types: Normal, Proximity, Character String, and RegEx. The
vast majority of your searches will be performed with the Normal Search type.

Normal Search is described below. See Proximity Search , Character String Search
, or RegEx Search  for details on those search types.

Normal Search

Search In: Choose which Bible text to search here.

Search Text: Specify the word, words, phrase, or expression  to search for here. Click
View Word List to help find words to search for with the Word List dialog .

Search Method controls how your search will be performed.
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Find verses with ALL of the words specified finds verses that have each word from
your Search Text. This is equivalent to a "logical and" search.

Find verses with ANY of the words specified finds verses that have at least one of the
words from your Search Text. This is equivalent to a "logical or" search.

Find verses with the exact PHRASE specified finds verses that have all of the words
from your Search Text, in the exact order that you provided them. This has the same
effect as putting your search words in quotes: "this is a phrase". If you put your

search words in quotes, phrase searching is assumed whether or not you select this
option.

Find verses matching the BOOLEAN EXPRESSION specified interprets your Search
Text as a Boolean expression, described in Advanced Search Expressions . This
option is included for clarity, but using any of the Boolean operators described in 
Advanced Search Expressions  (&, |, !, ^) will automatically force expression
evaluation, so it is not strictly necessary to select this option when using Boolean
operators.

Search Options provide additional control over how words will be compared during the
search.

Match case makes your search a "Case Sensitive" search. With this option selected,
searching for lord would find verses that have the word lord but only in lower case,

so Lord would not match lord.

Find all word forms performs "English stemming" reduction on each word and
searches for any form of the words specified. With this option, a search for love would

find loves, loving, lovest, loveth, etc. This only works with English text.

Find close word matches performs "fuzzy matching" comparisons on words. A search
for color would find colour, colours, etc. This can be useful when you are unsure of

the spelling of a word, but can often match unrelated words. To find words to search
for when you are unsure of the spelling, it may be easier to use the Word List dialog

 instead.

"Substring search" finds partial word matches. With this option selected, searching
for god would find god, godly, ungodly, etc. This is equivalent to using a wildcard on

each end of each word (*god*). Wildcards are explained below.

Words of Christ only limits your search to "red letter words" in the selected Bible
module. This only works when the selected module supports red-letter display (such
as the KJV). See also Search KJV Words of Christ .

Include footnotes in search tells SwordSearcher to include the margin/translator
notes in the verse text when searching. Not all Bible texts have footnotes.

Consonant search is for Bible modules containing Hebrew text, such as the Old
Testament in the Textus Receptus module. Selecting this option ignores vowel points
during searching.

You can apply most of these search options on a per-word basis by using Advanced
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Search Expressions .

Search Range 

Search Range allows you to specify which verses to search. Choose All to search the
entire Bible. Choose Old Testament or New Testament to limit your search accordingly.
Use Book if you wish to limit your search to a single book in the Bible.

You can specify a custom search range by clicking the Custom button. A custom search
range can be manually typed and may contain multiple books, non-contiguous ranges,
specific chapters, etc. Selecting Custom > Manually enter search range opens an input
dialog in which you may type ranges like "Joh 1-5" or "Ge-Re" or "Psalm 23; 119" etc.

Sample "Custom" search range menu. Pre-defined search
ranges can be edited by the user.

The Custom search range menu includes a variety of pre-defined search ranges. You may
add, remove, or change items in the pre-defined search range list by selecting Custom >
Edit pre-defined ranges.

Do Search

Clicking Do Search will perform your search and load the matching verses, with
matching words highlighted, in a Verse List panel .
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Wildcards

Any time you want to search for words that begin with or end with some letters, use a
wildcard (*). Searching for god* would find god, godly, etc. Wildcards can be used before,

after, and inside of a word.

You can use the wild character symbol (?) to replace a single character. Searching for lo?

e would find love, lose, etc.

Searching for Strong's Numbers

You can search the KJV and KJVSL Bible modules for Strong's Numbers to find instances
of similar original language words in the KJV. To search for a Hebrew Strong's number,
prefix the number with an H (like H1234). To search for a Greek Strong's number, prefix
the number with a G (like G1234). See the King James Version with Strong's Links  for
details on using the KJVSL and Strong's Links.

Can't find a verse you know is there?

Here are some things to check if SwordSearcher can't find a verse you are looking for.

· Are you searching the right Bible text? Make sure you're not searching a non-English
text, like the Textus Receptus, for an English word.

· Are words spelled correctly? A common mistake is to search the KJV with American
spellings of words like colour, favour, or saviour. Use the close word match option or
the Word List  dialog if you are unsure about the spelling of a word or name.

· Are you searching the right range of verses? If you've previously restricted your search
to the Old Testament, then go on later to search for a word that appears only in the
New Testament, no verses will be found. Click All under Search Range and try your
search again.

· Are you using Match Case unnecessarily? If you've selected the Match case Search
Option, but search for jesus, no words verses will be found because it only appears as

Jesus or JESUS. Be sure to un-check Match Case unless you are sure you need it.
· Are you looking for words that may appear near each other but not necessarily in the

same verse? In that case, use a Proximity Search .

4.1.1 Word List Dialog

The Word List dialog is a helper function of the Search Bible  dialog (Normal Search
page). Open it by clicking the View Word List button in the Search Text area of the
Search Bible dialog under Normal Search.
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Sample Word List dialog

The Word List dialog helps you locate words in Bible text for searching. It is especially
useful in determining the spelling of a word or name of which you are unsure.

The Complete word list shows every word indexed in the selected Bible text.

Begin typing a word in the Text entry box. The Complete word list will update as you
type to select the first matching word. The Suggested alternatives area also continually
updates as you type, showing you words that may match what you are looking for. This
is where you should be looking if you are typing in a word and are unsure of your
spelling.

Clicking OK or pressing Enter will add the selected word to your Search Text in the
Search Bible dialog. Double-clicking a word in either list will perform the same operation.

4.1.2 Proximity Search

Proximity Search is a specialized search type on the Search Bible  dialog.43
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Sample Search Bible dialog showing Proximity page

A Proximity Search finds words near each other but separated by verses.

In the example above, we want to find passages in the KJV that contain the word Paul
within 5 verses of the word church. This search would find verses like Acts 15:22, which
contain both words, and would also find passages like Acts 14:19-23, which contain both
words but not in the same verse.

Chapter Boundaries defines how SwordSearcher should treat chapters during a proximity
search.

Find within N verses in same chapter performs a proximity search that only returns
results within the same chapter and within the number of verses specified under
Search Text.
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Find within same chapter performs a search that finds results that appear within any
number of verses as long as they are in the same chapter.

Ignore chapter boundaries performs a search that returns results within the number
of verses specified without regard for chapter boundaries.

Search Options and Search Range for Proximity Search work the same as they do in
Normal Searches .

Search Text in Proximity Searching supports Advanced Search Expressions .

4.1.3 Character String Search

A Character String Search is a specialized search type on the Search Bible  dialog.

Sample Bible search dialog showing Character String Search page

43

56

43



Searching and Indexing 51

© 2015 StudyLamp Software LLC

A Character String Search searches for an exact sequence of characters in a verse,
including spacing and punctuation.

Please note that you should not use this function to only search for phrases.  The Normal Search  type
provides a more powerful phrase search method.

In the example above, we want to find verses containing the characters me? in sequence.

It is important to remember that in a Character String Search, spaces matter.

An example which shows the usefulness of this search type is to search for a question
mark (?), which would show all of the verses in the Bible with questions in them.

The Search String entry only supports explicit strings of text. It does not process
advanced search expressions.

4.1.4 Regular Expression Search

A RegEx (Regular Expression) Search is a specialized search type on the Search Bible
dialog. RegEx search is a highly advanced search type. Most users can skip this
section.

If you do not understand RegEx, don't worry! Just skip this section and move on. The
Normal Search  SwordSearcher provides is all the power 99.99% of users need.
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Sample Search Bible dialog showing RegEx Search page

A Regular Expression (usually called RegEx) is a special way of describing a search
pattern, and can include positions (anchors), character types, repetition, quantification,
etc. A Regular Expressions tutorial is outside the scope of this manual. For an
introduction to RegEx, see Regular-Expressions.info on the Web.

Certain kinds of searches can only be done with a RegEx.  For example, you can find all
of the verses that begin with the word "Oh" with the following RegEx search:

^oh\b

^ means "start of line" (in a SwordSearcher RegEx, a "line" is the same as "verse"). oh

matches the letter sequence oh. \b means "word boundary," which can be a space or

punctuation or any other non-letter character.

Remove pre- and post-scripts from verses is important because it can affect anchor

http://www.regular-expressions.info/tutorial.html
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matching in the search. The "pre and post" scripts are the text that normally appears
before the first verse in a printed Bible, like "A Psalm of David, when he fled from
Absalom his son." in Psalm 3:1; or after the last verse, like "Written to the Romans from
Corinthus, and sent by Phebe servant of the church at Cenchrea." in Romans 16:27.
SwordSearcher includes these in the verse proper, but normally when specifying anchors
in a RegEx search, you would want these text strings excluded.

Technical information: SwordSearcher uses Perl-style RegEx, specifically the PCRE
library.

When typing a RegEx, look for a "red dot" to the right of the text entry area.  When the
red dot appears, the RegEx is incomplete or invalid. You can hold your mouse pointer
over the red dot to see an explanation of the error.

4.2 Full Library Search Dialog

To open the Full Library Search dialog, select Full Library Search from the Search menu,
or press Alt+L, or click the Full Library Search button on the Search toolbar .

A Full Library Search performs a "global" text search in SwordSearcher. It can search
every single library module loaded, and provides the most of the search features of the 
Search Bible  function (Normal Search type). Search results are loaded in a Library
Search Results panel .

Note: there two cases when the Full Library Search should not be used:

· If you wish to search a single Bible text, use the Search Bible  dialog instead. The
Search Bible dialog provides some additional control for Bible searches and loads a 
Verse List  for the search results.

· If you are looking for verse references in library modules, use either the Go To
Verse toolbar  (which can open a Verse Guide panel ), or the Topic and Verse
Guide , both of which are designed specifically for verse reference indexing.

Here is a sample of the Full Library Search dialog:
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Sample Full Library Search dialog

Search Text: Specify the word, words, phrase, or expression  to search for here.

Search Method controls how your search will be performed.

Find entries with ALL of the words specified finds entries that have each word from
your Search Text. This is equivalent to a "logical and" search.

Find entries with ANY of the words specified finds entries that have at least one of the
words from your Search Text. This is equivalent to a "logical or" search.

Find entries with the exact PHRASE specified finds entries that have all of the words
from your Search Text, in the exact order that you provided them. This has the same
effect as putting your search words in quotes: "this is a phrase". If you put your

search words in quotes, phrase searching is assumed whether or not you select this
option.

Find entries matching the BOOLEAN EXPRESSION specified interprets your Search

56
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Text as a Boolean expression, described in Advanced Search Expressions . This
option is included for clarity, but using any of the Boolean operators described in 
Advanced Search Expressions  (&, |, !, ^) will automatically force expression
evaluation, so it is not strictly necessary to select this option when using Boolean
operators.

Search Options provide additional control over how words will be compared during the
search.

Match case makes your search a "Case Sensitive" search. With this option selected,
searching for lord would find entries that have the word lord but only in lower case,

so Lord would not match lord.

"Substring search" finds partial word matches. With this option selected, searching
for god would find god, godly, ungodly, etc. This is equivalent to using a wildcard on

each end of each word (*god*). Wildcards are explained below.

Find all word forms performs "English stemming" on each word and searches for any
form of the words specified. With this option, a search for love would find loves,

loving, lovest, loveth, etc. This only works with English text.

Find close word matches performs "fuzzy matching" comparisons on words. A search
for color would find colour, colours, etc. This can be useful when you are unsure of

the spelling of a word, but can often match unrelated words.

You can apply these search options on a per-word basis by using Advanced Search
Expressions .

Search In defines the scope of your search.

Search set of modules: Select this to choose from various module sets. You can use
the pull-down selection list to pick other sets, such as only Books and Dictionaries,
only Commentaries, etc. You can also use the Configure Sets button to set up your
custom Module Sets .

Search single module: Select this to choose a single module in SwordSearcher to
search.

Clicking Do Search will perform your search and load the results in a Library Search
Results panel .

4.3 Search KJV Words of Christ Dialog

To open the Search KJV Words of Christ dialog, select Search KJV Words of Christ from
the Search menu, or press Alt+F2.

This is what the dialog looks like:
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Sample Search KJV Words of Christ dialog

This function performs a KJV Bible module search, but restricts the search to the "red
letter" words of Christ. Search results are displayed in a Verse List panel .

If you need more control over your search, you can use the Search Bible dialog  with
the "Words of Christ Only" option selected.

The Search Words of Christ function supports the same Advanced Search Expressions
available to normal Bible searches.

4.4 Advanced Search Expressions

The Search Toolbar , Search Bible dialog  (normal and proximity searches), Search
KJV Words of Christ , and Full Library Search  functions all support an advanced
search expression syntax, described here.

Note that in most cases, the search options provided in the Search Bible  and the Full
Library Search  dialogs will provide you with enough control over the search that it will
not be necessary to use any advanced search expressions. You can safely skip this help
topic if you only want to use SwordSearcher's standard search features.

Simple Word and Phrase Searching

A simple search can include one or more words, like this:

lord jesus christ

A Bible search for the above would find verses containing all three words, in any order or
location in the verse. A library search would likewise find book and commentary entries
with all three words, appearing in any order or location in the entry text. This is referred
to as a Boolean AND search.

A phrase search is specified by using quotation marks, like this:

"lord jesus christ"

The above would find verses or entries that have the three words in the exact order.

Most searching in SwordSearcher disregards punctuation. A phrase search ignores
punctuation in such a way that a search for "one two" would match text like "one, two."
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or "one two" or "one! two!" If you must perform a Bible search that includes punctuation,
use Character String Search .

Boolean Expressions

Boolean expressions allow you to combine comparison operations like OR, AND, NOT, and
XOR, and use parentheses to group operations.

A simple example is to take our original search, lord jesus christ, and make it find

verses with any of the words, rather than only verses with all of the words. We do this by
adding the logical OR operator, which is a pipe (|) symbol (Shift+\ on your keyboard):

lord | jesus | christ

Unlike the first example, which would only find verses or entries with all three words, this
search will find verses or entries that have any of the three words.

Now suppose we wanted to do something more complex, like find verses that have the
phrase "lord jesus" or the word "christ". That search would look like this:

"lord jesus" | christ

Boolean expressions can also include parentheses to group operations. So, if you want to
find any verse that has the three words lord, jesus, and christ, OR the exact phrase "lord
god", you would specify your search like this:

(lord & jesus & christ) | "lord god"

The & symbol is the logical AND operator, and isn't actually required since AND is
assumed. It's included here for clarity.

Here is a complete list of the Boolean operators SwordSearcher supports, in the order of
precedence:

( ) precedence, as in above example

! Logical NOT

& Logical AND

| Logical OR

^ Logical XOR (exclusive OR, meaning: one but not both)

Again, a phrase is specified by placing text in quotes: "this is a phrase". If no Boolean

operators are included in your search text, AND (&) is assumed.

Spelling out Boolean operators like AND or NOT is not supported because those words
may frequently be part of the search itself. Therefore you must use the operator tokens
listed above (!, &, |, ^).

Modifier Tokens

50
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The advanced search expression syntax supports several enhanced comparison modes
that are applied on a per-word basis by using modifier tokens. A modifier token is placed
just before or just after a word, or in some cases, inside a word.

For example, the wildcard token (*) placed after some letters tells SwordSearcher to
search for any word starting with the letters. A search for

god*

Finds god, godly, etc.

Here is a complete list of token modifiers and their functions, followed by more detailed
examples:

Token Name Function

* (asterisk) Wildcard Stands for any sequence
and count of letters.

? (question mark) Wild character Stands for a single
character

_ (underscore) Case sensitive compare Forces the word to be
compared sensitive to
case.

= (equals symbol) English stemming Finds all forms of the word

~ (tilde) Fuzzy (loose) matching Finds words that mostly
look the same as the
specified word

Wildcard (*)

Use the wildcard token to find any string of characters. Examples:

god*
*god
*god*
g*d

Wild character (?)

Use the wild character to stand in for any single character.

lo?e

Finds love, lose, etc.

You can freely mix * and ? tokens in a word as needed.

Case sensitivity (_)

The Search Bible and Full Library Search dialogs allow you to do a case sensitive
search, but the case sensitivity token makes it possible to mark a single word as case
sensitive. For example:
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_lord & god

Finds verses with both the words lord and god, but only matches the word lord when
the letters are all lower case. The word god will still match god, God, and GOD,
because it lacks the case sensitivity modifier token.

English stemming (=)

Place the stemming token after a word to find all word forms. For example:

jesus & love=

Finds verses that have the word jesus and also a form of the word love, such as love,
loved, loveth, and lovest.

The English stemming comparison function only works on English texts. It works with
older word forms like those in the KJV.

Fuzzy matching (~)

Use the fuzzy matching token to tell SwordSearcher to match words that mostly look
the same. This is a "loose matching" function and can be useful when you are not
sure of the spelling of a word. For example:

color~

Finds verses with the word colour and colours.

While fuzzy matching is useful, it can frequently be too lenient. If you need help
finding the spelling of a Bible word, you can also try using the Word List function
of the Search Bible dialog, which implements a fuzzy matching list but allows you to
search for just the words you want once you find them.

Tips

· A search that combines a phrase search and one or more words is assumed to be a
Boolean AND search for the phrase and the words. Therefore, the following search texts
are equivalent:

"jesus christ" saviour
"jesus christ" & saviour

· You can use wildcards and other modifier tokens inside of a phrase. For example, the
search:

"love= not"

performs stemming on love and would find verses like the following:

Proverbs 15:12  A scorner loveth not one that reproveth him: neither will he go unto
the wise.
Proverbs 20:13  Love not sleep, lest thou come to poverty; open thine eyes, and thou
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shalt be satisfied with bread.
Revelation 12:11  And they overcame him by the blood of the Lamb, and by the word
of their testimony; and they loved not their lives unto the death.

· Searching in SwordSearcher always ignores punctuation, unless you use a Bible
Character String search  or Regular Expression search .

· Boolean operators do not need to be padded with spaces. The following search texts
are equivalent:

jesus|christ|saviour
jesus | christ | saviour

· Boolean operations are evaluated in a strict order of precedence. The table under 
Boolean Expressions above lists them in the order that they are evaluated. If you are
having difficulty getting the desired effect with a Boolean search, it can often be helpful
to use parentheses around the operations you want evaluated first. (A complete
discussion of Boolean logic is outside the scope of this documentation.)

4.5 Topic and Verse Guide

The Topic and Verse Guide tool incorporates the functions of a Verse Guide panel , and
adds the ability to create a dynamic index of all Books and Dictionaries for a given topic.

To open the Topic and Verse Guide, select Topic and Verse Guide from the Search menu,
or press Alt+T, or click the Topic Guide button on the Search toolbar .

The Topic and Verse Guide remains floating above the main window until you are finished
using it and click Close.

Using the Guide as a Topical Index

50 51
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Sample Topic and Verse Guide shoing index for INSPIRATION

Entering a topic and clicking Search (or pressing Enter) loads a list of library modules
with that topic. The above example shows a topic guide for inspiration. Any entry that
has a title containing the word is included in the index.  Clicking an item in the list will
load it in the appropriate panel  of the main window.

The Matching option controls how strict topic matching is. There are three levels: strict,
normal, and loose. Normal matching will almost always yield the best results.

The Sort book entries by option changes how results from books are organized in the list.
Selecting Entry Title organizes all book results by entry title, and groups multiple books
with same-title entries together (as in the above sample under INSPIRATION). Selecting 
Book Title organizes results by book module.

The Topic Guide is restricted to indexing titles of entries. While this is typically sufficient
for locating material on a topic, a Full Library Search  can be performed to search the
actual content of each library resource for a given word or phrase if more reference
material is required.
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Using the Guide as a Verse Reference Index

The Topic and Verse Guide also incorporates the functionality of a Verse Guide panel ,
giving you an exhaustive index of verse references across the entire library.

Sample Topic and Verse Guide showing references to 2Ti 3:16 and
17

Entering a verse reference or range of verses (as in this example of 2Ti 3:16-17) loads a
list of all library material that reference the verse(s). Clicking an item in the list will load
it in the appropriate panel  of the main window, with the relevant references
highlighted.

For more details on Verse Guides, see the Verse Guide panel  topic.
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4.6 Module Selection Tool

If you are looking for a module that you don't see among the visible tabs, you can use
the Module Selection Tool.

The Module Selection Tool lists all of the installed library modules, even modules with
hidden library tabs. (See Managing Library Tabs .)

On the File menu, click Select Library Module to open the module selection tool.

38
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Sample of the Select Library Module window.

Clicking the module title will open it in the appropriate panel. You may also use the arrow
keys to select an item on the list.

The module selection tool supports filtering.  If you know what you are looking for, you
can start typing a word to filter out items that do not match. For example, typing "mor"
filters out all modules that do not have the letters "mor" in their title, like this:
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Sample of filtered module list

The status bar at the bottom of the Select Library Module window shows the current
filter.

The Bible, Book, and Commentary menus each have a Select function that opens the
module selection tool with just the Bible, Book, or Commentary lists expanded in the
window. The User menu has a Select User Module function that opens the module
selection tool with only user-editable modules visible.

Modules with currently visible tabs appear with a tab icon. User-editable modules appear
with a pen icon.

Advanced Use: Shift+Click an item to toggle tab visibility. (See Managing Library Tabs
 for details.) Right-click an item for a pop-up menu with additional options. User

modules can be renamed, deleted, printed, and exported from the pop-up menu, as with
the main User menu.

4.7 English-Strong's Indexer

Open the English-Strong's Indexer by selecting English-Strong's Indexer on the Search
menu, or press Ctrl+F2, or click the English-Strong's Indexer button on the Search
toolbar .

The English-Strong's Indexer (ESI) is a word study tool that shows which Greek or
Hebrew words the King James translators translated into a given English word. (The ESI
only uses the KJV because the KJV is the only text in SwordSearcher that is indexed by

38

35



SwordSearcher 766

© 2015 StudyLamp Software LLC

Strong's numbers.)

The ESI offers functionality similar to the Young's Analytical Concordance. If you want to
search for Strong's numbers, see the topic on the King James Version with Strong's Links

.

Sample English-Strong's Indexer, showing New Testament index of GREATLY

In this example, the word "greatly" has been indexed in the New Testament. The results
show each Strong's Number for every Greek word that was translated to "greatly" in the
KJV, and a sample of verses for each Strong's Number. Also shown is the Strong's
Lexicon definition for the Greek word.

(Note that if you are using the evaluation version of SwordSearcher, the definitions are
omitted because the Strong's lexicons are only available in the Deluxe version.)

You can limit your index to either Testament, or search the entire Bible.

80
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Here is a breakdown of the result data, shown from a portion of the results from a search
for "greatly:"

Strong's number, word, and how many
times this word was translated into the
given English word.

Strong's lexicon definition of the
Strong's number.

(This is a sample screen shot.
These links are not active in the

help file.)

Breakdown of each English phrase
containing the given English word, and
how many times that phrase was used
for this Strong's number, with up to
five example verses linked.

4.8 Library Table of Contents

Open the Library Table of Contents by selecting Library Table of Contents Tool on the
Search menu or by pressing Shift+Alt+T.

The Library Table of Contents is a central location for viewing the entire index of the
installed library, including every Bible, Book, and Commentary module and their entries.
It is merely an alternative way to access module entries or to see the table of contents
for a module without using the pull-down menus in the display panels.
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Sample of the Library Table of Contents tool.

Clicking on an entry title in the list opens it in the appropriate panel in the main window.
Right-clicking an item in the list provides options for copying the index text to the
Windows clipboard.

Hint: you can right-click the Book panel and select "Table of Contents Tool" to open the
above window with the active module and entry pre-selected.

4.9 Find Related Verses

The Find Related Verses dialog helps you study a verse (or passage) and its words by
giving you a quick way to see how the words are used elsewhere in Scripture.
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Sample Find Related Verses dialog

You can access the Find Related Verses dialog on the main Search menu, or by right-
clicking a verse and selecting Find Related Verses. or with the Find Related Verses
Widget .

This search function reduces the amount of time you would otherwise spend typing
search words during a study. As an example, study John 3:16. In the Bible panel, right-
click the verse and select Find Related Verses from the pop-up menu: (You can also do
this in a Verse List when reviewing search results.)

143
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Sample Bible panel showing pop-up menu

The Find Related Verses dialog opens with the verse pre-set:
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Sample Find Related Verses dialog showing John 3:16

The words from the verse are listed in the box on the left, sorted so that the least-
common words appear first. With the word list sorted this way, you can get immediate
ideas for further study. For example, check the boxes next to "begotten" and "loved."

Next, see Search Options on the right. Here is where you can control your search. Select
the "ALL" words method and Include all word forms. This tells SwordSearcher to find
verses with all of the words checked on the left, and to include all word forms of the
selected words.  Notice that as you select words and change the search options, the 
Status section updates to tell you how many verses will be found.  This way you can
easily refine your search, adding words or changing options to get a result list of a useful
size.

Click Do Search to perform the Bible search.  The resulting verses appear in a Verse List
, just like any other Bible search:25
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Sample Verse List showing related verse search results

All three of the additional verses are excellent cross-references. Note that because we
used Include all word forms, 1Jo 4:9 (with "love" instead of "loved") and 1Jo 5:1 (with
"loveth" instead of "love") have been included.

Spend some time experimenting with the Find Related Verses dialog. You will find that it
is a great way to learn how words are used throughout the Bible and it is sure to enhance
your study, making it convenient to compare Scripture with Scripture.

You can type any verse or passage in the Verse or Passage text entry box. However, this
tool is most useful with small portions of Scripture. Try to keep it down to a chapter at
most.

Select Find verses with ANY of the selected words if you want to see how a group of
words are used elsewhere but not necessarily together.  Select Find verses with ALL of
the selected words if you only want to find verses that use the same words you have
selected together.

The Find verses other than the current passage controls how the Status section shows
the results of your current options. It helps you avoid performing a search that would
only return the same verse (or verses in the passage) you are studying. However, once a
search is performed, the results will include all matching verses, even if they appear in
the specified verse or passage.

If you want the word list to be sorted alphabetically instead of the default "least-common
words first," un-check the Sort least-common words first option.

The Verse List  right-click pop-up menu includes an option to Find Related Verses for25
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Entire Verse List. This pre-loads the word list with all of the words in the verse list. Again,
this works better with small portions of Scripture.

If you find yourself using this search function frequently, you can add a Verse Widget
for one-click access.

4.10 Bible Word Cloud Generator

The Bible Word Cloud Generator is a visualization tool that can show you at a glance
what words are emphasized in a portion of Scripture.

This Generator should not be confused with the Word Clouds book module (part of the
Deluxe library).  The book module is a stylized, fixed set of word clouds, while the
Generator can create word clouds on-the-fly for any portion of Scripture you want, and
allows customization.

To open the Bible Word Cloud Generator, select it from the Search menu, or click the
Cloud icon on the Bible panel toolbar.

Here is an example showing the Bible Word Cloud Generator, set to the book of Romans:
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The first thing that is apparent is the author's emphasis on Christ and faith.  The word
cloud shows words weighted (size and color intensity) based on their relative frequency. 
That is, words used more often in the passage will be bigger and more intense than the
others.

Holding your mouse pointer over a word will show its word count, first use, and last use
in the passage. Click a word to show all of the verses from the passage with the word in
a verse list.

Use Passage to set the portion of Scripture used to generate the word cloud.  There is a
drop-down menu with several pre-configure ranges available. Important tip: a word
cloud is not useful unless it is built from a sufficiently large portion of Scripture, as the
relative frequency of words will not vary much without enough text. Generally, the
smallest amount of Scripture you will want to use is a single chapter. Whole books work
well.

The Scale Slider works a lot like a zoom control but also adjusts the size difference
between the words.

Don't include very common words prevents common words like "the" and "or" from being
included, which would make the word cloud of little use. You can click the gear icon to
edit the common word list. Also, you can right-click a word and select Add [word] to
common words list.

Combine word forms builds the word cloud with word forms combined, so that "love" and
"loveth" would appear under the single heading "love" and the word counts combined.

To change the color of the word cloud, or if the words appear as capital letters, right-click
in the cloud and use the pop-up menu.

Temporarily removing words from the word cloud

It can be useful to remove words as you examine a word cloud. For example, we may
want to remove the word "come" from the above word cloud and rebuild the cloud. This
removes the word from the list and does not count it when weighing the other words.  To
do so, right-click the word and select Remove [word] from this word cloud, or, hold down
CTRL and click the word to remove it.  This is temporary and the next time a word cloud
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is generated the word will be included again. You can remove multiple words this way
until you are satisfied with the appearance and content of the word cloud.

Saving or Copying

Word clouds can be very useful teaching tools, and you may want to use it in a
document. If you would like to save the word cloud as an image file, click Save to do so,
or click Copy to put a graphical image of the word cloud on the Windows clipboard.

Another use for word clouds: finding common associations within
Verse Lists

Verse List panels can generate word clouds as well. An interesting study can begin by
choosing a common but important word, like "love" (281 verses in the KJV), and then
viewing a word cloud based on all of the verses returned from the search. Click the word
cloud icon in a Verse List panel to do so. Note that word clouds are not very effective if
they are based on short verse lists, so this is only really useful with fairly common words.



SwordSearcher 776

© 2015 StudyLamp Software LLC

Sample word cloud, showing that the word LOVE frequently appears with GOD and LORD.

4.11 Passage Analysis

The Passage Analysis window gives you interesting details on any portion of Scripture
you specify, such as the Old Testament, Pauline Epistles, a book, chapter, or verses.

Open the Passage Analysis window from the Search menu, or right-click the Bible panel
and select Passage Analysis.
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Sample Passage Analysis window

Under Passage you can type or select a passage to analyze, including the entire Bible.
Use the pull-down menu to select from several predefined sections of the Bible.

Details Provided

The list of details depends on the passage being analyzed, and will include several or all
of the following:

Canonical verse numbers: This is the range of "global" verse numbers analyzed, where
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1 is Genesis 1:1 and 31,102 is Revelation 22:21. To learn the global verse number for a
particular verse, type the verse into the Passage box to analyze just that verse. (See
also Reference Pattern Search  for more details on verse numbers.)

Scope Contains: Lists the total count of books, total count of chapters, and total count
of verses in the passage. Also lists the total number of words. In Romans through
Philemon in the KJV, there are 43,490 total words and 3156 unique words. In this
context, "unique words" means the number of words in the passage without counting
multiple uses of each word.

Read-aloud time: The estimated reading time for the passage. This figure is based on
Alexander Scourby's narration of the King James Bible, and is a good gauge of the time
required to read verses in a natural, narrative manner. Most people will read silently in
less time than this figure.

Versification: breaks down the passage listing most and fewest chapters in a book,
most and fewest verses in a book, most and fewest verses in a chapter, with links to the
text.

Words: breaks down the passage listing most and fewest words in a book, chapter, and
verse, with links to the text.

Click See Complete Word List to view an exhaustive list of all of the words in the
passage, which can be sorted alphabetically, by frequency, or by "Passage
Uniqueness" (see below).

Top Words: lists the most common words in the passage. For English texts, common
words such as "the" and "a" are excluded from the Top Words list.

Most Unique: lists the most "unique" words relative to the rest of the Bible. Words that
appear only in the analyzed passage will score 100%, with the score diminishing as
words are more often found in other passages.

4.12 Reference Pattern Search

The Reference Pattern Search dialog finds verses by a pattern, such as "every fifth verse
in each chapter." 
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Sample Reference Pattern Search dialog

Open the Reference Pattern Search dialog on the main Search menu under Reference
Pattern Search.

Scope limits the pattern search to a specific Testament, Book, or passage.

There are several patterns to choose from. Enter the numerical value into the pattern you
want to examine, and click the Go button next to the pattern. All of the verses in the
pattern will be loaded into a Verse List .

Most of the patterns are "Nth verse" patterns where you specify N. For example, you can
find the 100th verse of each book by using Find the Nth verse of each book with a value
of 100 and clicking Go.

Find references in each book matching Chapter:Verse finds every C:V in the Bible. For
example, you can see every 3:16 of each book with this pattern search.

Find the last verse of each chapter and Find the last verse of each book load a verse list
with the respective verses.

Find N random verses isn't actually a "reference pattern." This function generates a
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random list of verses in the selected scope.  You might try this if you are looking for
something to start studying and want help getting ideas.

The usefulness of this information is left to the Bible student to determine. Most of the
search functions are provided primarily as a means of fact-checking teachings regarding
verse patterns in Scripture. Over the years, many claims have been made about such
patterns, and this tool can be used to check these claims.

From Genesis 1:1 to Revelation 22:21 is 31,102 verses. Use this to help determine
certain points, like "the middle verse." Since there are an even number of verses in the
KJV canon, there is no "middle verse," making the middle verses #15,551 and #15,552.
Entering 15551 in Find the Nth verse with a Scope of "Entire Bible" shows Psalm 103:1,
meaning the two middle verses of the Bible are Psalm 103:1-2. (The author of this
manual makes no claims regarding the usefulness of this information, but presents it as
an example of how one might fact-check a claim based on such data.)

Note that regardless of Bible version, SwordSearcher always uses the standard
versification of the KJV canon.

4.13 The King James Version with Strong's Links

The King James Version with Strong's Links (KJVSL) is a special Bible module in
SwordSearcher that includes links to Strong's definitions of Hebrew and Greek words in
the text. The KJVSL is searchable by Strong's numbers as well.

The explanation of the KJVSL also applies to the Spanish module SRVSL.

To view the KJVSL, click the KJVSL tab in the Bible panel , or select it on the Bible
menu.
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Sample of the KJVSL Bible module, showing pop-up Strong's definition

(Note: The definition portion of the pop-up is not included in the evaluation version.)

Holding the mouse pointer over a Greek or Hebrew link will pop-up the Strong's definition
of that word. You can click on the link to be taken directly to that entry in the
corresponding lexicon in the Book panel . 

Searching for Strong's Links/Numbers

You can perform searches in the KJVSL for Strong's Links. Searches are performed like
regular searches except that instead of typing a word to search for, you type a G or H
followed by the Strong's Number. So to search for other occurrences of the Strong's Link
λογος, you would search for G3056. a G prefixes Greek Strong's numbers, and an H
prefixes Hebrew Strong's numbers. You can get the Strong's number for a Strong's Link
by simply holding your mouse pointer over the link.

If you right-click on a Strong's link in the Bible panel, the pop-up menu adds a function
for searching for that Hebrew or Greek word:

17
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Sample right-click menu for a Strong's link

Clicking Search Bible for G3056 would open the Search Bible  dialog with the
appropriate search text filled in. You can also type a Strong's number (such as G3056)
directly into the Search toolbar  (with the KJVSL active) to perform the same search.

Note that you can search the KJV for Strong's numbers as well. If you search the KJV for
a Strong's number, the results will show the English words for the Strong's link.

A word of caution about the KJVSL

The KJVSL is not a true interlinear Bible. Not all Strong's Links actually map to the direct
Hebrew or Greek word that is found in the original language on a particular verse. This is
due to the fact that Strong's Lexicon does not include every form of the Hebrew or Greek
words that appeared in the original language texts. So while the Strong's Links and
lexicon are useful tools, they are not here to help anyone "retranslate" the Bible. If you
need to read the actual Greek or Hebrew text of the Bible, use the Textus Receptus (TR)
Bible text. Remember also that Strong's lexicon definitions are glosses, not thorough
definitions.

4.14 Scan Text for Verse References

The Scan Text for Verse References tool (Search menu, Search toolbar, or Alt+F5) will
save you a lot of time and tedium when researching topics on the Web. Have you ever
been reading a web page with verse references throughout the text and wished you could
quickly see the verses referenced?

That's the primary purpose of the Scan Text tool. Any text you type or copy into the Scan
Text window is automatically "scanned" for references to Scripture. Each recognized
reference is highlighted and turned into a hot-link. You can hold the mouse pointer over
the references to read the verses in a pop-up, or click them to load them into the Bible
panel, or load all the verses into a Verse List panel.

Tip: The Scan Text for Verse References tool should not be confused with the Verse Guide . The Scan Text
tool is used to automatically link verse references from text you provide from outside of SwordSearcher.  The
Verse Guide is used to see all references to a verse in the SwordSearcher library.

Here's how the tool looks with some text pasted in from an article from the Internet:
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Sample image of Scan Text for Verse References tool

In the above example, text was copied from Internet Explorer using the Windows
clipboard. We could just as easily have copied text from any other application in
Windows.  (Most applications allow you to copy text to the clipboard by marking it with
the mouse and pressing Ctrl+C.)  Then we pasted the text into the Scan Text tool (by
using the Paste button on the toolbar), and the above picture shows how the result looks
-- each reference is highlighted, and we can hold the mouse pointer over a reference to
read the Bible text as we read along in the article.

You can also use the Scan Text for Verse References tool to load long lists of verses into
a Verse List panel -- just type in all the references, on as many lines as you wish, and
click Load verses into Verse List Panel and Close. 

Tip: You can also "drag" text from other applications into the text box, skipping the Copy
and Paste steps.



SwordSearcher 784

© 2015 StudyLamp Software LLC

Additional options

To quickly clear the text in the Scan Text window, click Clear on the toolbar or press Ctrl
+D.

Click Settings to adjust how the Scan Text tool handles invalid chapter and verse ranges
and what happens when you click a verse reference.

Standardizing Verse References

If you click Copy and then Copy All Standardized (or press Shift+Ctrl+C), the Scan
Text tool will rewrite all of the recognized verse references in the text with standard
SwordSearcher formatting and copy the entire text to the clipboard. This is useful if you
are working on a user Book or Commentary entry and need to verify verse references in
some text before putting the text into your entry.  This can also be used to update "old
style" references found in older commentaries that use Roman numerals to modern
format. For example:

1. Insert non-standardized verse references.

2. Click Copy, Copy All Standardized.
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3. References are standardized and the text is copied to the clipboard.

4.15 StudyClick

Any word in a Bible, Verse List, Book, or Commentary panel can be instantly turned into
a clickable link. All you need to do is hold the CTRL key as you move the mouse pointer
over the words. Once you start using StudyClick you will find that it saves a lot of time,
reducing the amount of typing or clicking you need to do to accomplish searches or
lookups.

The following examples show how StudyClick works with the default settings. You can
change what the links do in StudyClick Options .

CTRL+Click

StudyClick sample: Holding CTRL while moving the mouse pointer.
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The sample image above shows what happens when you hold CTRL and point at a word. 
The word "inspiration" has become clickable, and a pop-up shows the first and last use of
the word in the Bible.  Clicking the word (while still holding CTRL) would show all of the
verses in a new Verse List.

CTRL+ALT+Click

StudyClick sample: Holding CTRL+ALT while moving the mouse
pointer.

In this image (above), CTRL+ALT is being held down instead.  Clicking the word (while
still holding CTRL+ALT) would open the Topic Guide  for the word. 

A Different StudyClick option

StudyClick sample: using Webster's 1828 Dictionary for word lookup.

This shows one of the many additional options  you can choose from for StudyClick:
lookup in Webster's 1828 dictionary. The preview shows an excerpt of the definition, and
clicking the word would open the full definition in the Book panel.

Tips
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To use StudyClick on more that one word at a time, you can mark the words first with
your mouse, and then use StudyClick on the selected text.

Words that are already linked will not change into StudyClick links.

StudyClick with Verse Links

Verse links have special meaning in SwordSearcher and work differently with StudyClick.
By default, when you hold down CTRL and click a verse link, a Clone  Bible Panel will
open for the chapter in which the verse appears, so you can examine the full chapter
context of the verse without changing your place in the main Bible panel. Different
options are also available on the StudyClick Options  page under When I hold CTRL
and click a verse link... Also, you can CTRL-click the non-linked verse tags in the Bible
panel for the same effect.
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5 Copying and Exporting Text

SwordSearcher provides several functions for copying, printing, and exporting text.

Copying Verses and Text to the Windows Clipboard

The Bible , Book , Commentary , and Verse List  panels all support copying text
by marking with the mouse and pressing Ctrl+C.

A Copy Verse Verse Widget  in Bible and Verse List panels makes it easy to copy a
verse you see with just one click.

For Bible verses, you will usually want to use one of the specific verse copy functions,
which allow you to control the formatting of the verse output, and also alleviate the need
to mark any text at all. See Copying Verses to the Clipboard  for details.
SwordSearcher can also be used on standby to automatically paste Bible verses into
other applications such as email and word processing documents. See Automatically
Pasting Verses into Other Applications . Using these methods to copy verses allows you
to control the formatting  of the verse output.

Printing Text

The Bible, Book, Commentary, and Verse List panels each have a Print This Window item
on their right-click pop-up menus that prints out the text from the panel exactly as it
appears on your screen.

The File menu has several self-explanatory print functions.

For printing verses specifically, see Printing Verses . For printing more than one Book
or Commentary entry at once, see Printing Book and Commentary Entries .

Exporting Text to Files

You can export verses to a file much in the same manner as copying to the clipboard by
using the Export Verses... functions on the File menu.

5.1 Configuring Verse Formatting

Many of the functions for copying, exporting, or printing verses in SwordSearcher allow
you to define the format of the verse output. To configure how verse text is formatted
when copied to the clipboard, select Configure Copy/Export Formatting from the Edit
menu on the main SwordSearcher menu.
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Sample Verse Export Formatting dialog

Main Style: There are several styles to choose from. Experiment by changing the style
and viewing the sample. The style controls the basic formatting of verses -- where the
reference will be, whether or not each verse is on its own line, etc. If you would like to
change the abbreviations used for Bible book names, see custom Bible Book
Abbreviations .

Include Version Tag: When checked, the output will include the version abbreviation.

Bold Verse Tags: When checked, verse tags (e.g., John 1:1-13) will be formatted in bold.

Include Paragraph Markers: When checked, pilcrows (¶) are included before verses that
begin new paragraphs. (Paragraphs are according to the Scrivener Paragraph Bible,
1873.)

SuperScript Verse No. (I, J, K, L): Use this option combined with styles I-L to make the
verse numbers superscript in the text.

Keep Red-Letter Formatting: If the Bible text supports it (as the KJV does), words of
Christ will be formatted with the color you have chosen in Preferences under Text Display
Options .

Keep Italic Formatting: When checked, italic formatting is retained in Bible texts that use
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italics such as the KJV. Un-check this option if you wish to have italic formatting removed
in the copied text.

Add Brackets for Italic Words: When checked, italicized words are placed in brackets.

Include {Footnotes}: When checked, footnotes from the Bible module will be placed in
{curly braces} and included.

Font settings: You can choose a preferred font and size for printing and copying.

There are three options controlling how your preferred font is used in clipboard
operations. It is recommended that you use the default, first option. However,
regardless of what you choose here, other applications will ultimately decide what
font is used when pasting in text. SwordSearcher can only include information on the
clipboard, it cannot force other applications to honor these settings.

All Italics: This forces the entire output to be italicized.

· Let paste application choose font: Recommended.
With this option selected, SwordSearcher will omit your selected font settings from the clipboard when
copying verses. When you paste them into another application, that application will decide what font to
use for the pasted text. Usually, this means that pasted text will appear with the same font and size as
the target document.

· Use my font on the clipboard:
With this option selected, SwordSearcher will include your chosen font and size when copying verses to
the clipboard. When you paste them into another application, the application will usually retain the font
settings you choose here.

· Force plain-text clipboard mode:
This is a compatibility mode option which disables fonts and formatting when copying to the Windows
clipboard. If this option is selected, the font and other formatting settings have no effect for clipboard
copy. Only use this if you are having problems with pasting into another application.

Note that the settings you choose here do not affect text that is copied by
marking text with the mouse. In that case, the text is copied as it appears on the
screen. The Verse Export Formatting options are applied when using the various Copy
Verses functions in the software, such as when you right-click a verse in the Bible panel
and select the Copy Verse item, or when using the Copy Verses function on the Edit
menu or toolbar, or from the Copy Verse Widget .

5.2 Copying Verses to the Clipboard

One of the most useful features of SwordSearcher is the ability to copy verses to the
Windows clipboard for use in other Windows applications, such as email, chat, word
processors, etc. SwordSearcher offers several easy methods of verse copying.

From the Verse List and Bible Panels

Both the Verse List  and the Bible  panels have verse widgets and right-click pop-up
menus for quickly copying verses to the clipboard. Copying verses in this manner uses
your export formatting options .

Using the Copy Verse Widget: Click the Copy Verse Widget to copy the verse to the
clipboard. Shift+Click the widget to copy a range (from the verse to another verse in the
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chapter). (See Verse Widgets .)

Example of copying a verse to the clipboard with the
Copy Verse Widget in the Bible panel.

Using the right-click menu: if you have the verse widget disabled, you can right-click a
verse in the Bible panel and use the pop-up menu to copy verses.

Example of copying verses to the clipboard by right-clicking a verse in the Bible
panel

From the Copy Verses Dialog

To copy a verse or a list of verses you have in mind, you can use the Copy Verses dialog.
Select Copy Verses from the Edit menu or press F5.
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Sample Copy Verses dialog

Enter the verse or list of verses you wish to have copied to the clipboard. For example:

Joh 3:16 would copy John 3:16.

Eph 6:17 Heb 4:12 would copy Ephesians 6:17 and Hebrews 4:12.

Ge 1 would copy Genesis chapter 1 (all verses).

2Ti 3:16-17 would copy 2 Timothy chapter 3, verses 16 and 17.

For ease of typing, you can substitute a period for a colon or omit spaces. For example,
you could enter the first example as Joh3.16 instead.

See Book Abbreviations  for the book abbreviations SwordSearcher uses. It is not
necessary to match these exactly. 1Tim would be recognized the same as 1Ti, Mar would

be recognized the same as Mr or Mk for the book of Mark, etc. If you are unsure of the

book abbreviations, the general rule is to use the first three letters of the book. For books
with numbers, like 1 Timothy, enter them without the space, e.g. 1Ti, 1Co, 2Ki, etc., to

avoid confusing book numbers with verse numbers in a list. It is best, though not
necessary, to use the standard abbreviations SwordSearcher uses to lower the possibility
of SwordSearcher misinterpreting the book you are trying to specify, especially with
Philemon (Phm) and Philippians (Php).

Click OK (or press Enter) to copy the verse(s). Click Configure Formatting to change the
verse formatting options with the Configure Copy/Export Formatting dialog .

Tip: You can "drag" selected text into the Specify Verse(s) box from another application
(or from inside of SwordSearcher) and all of the valid verse references from the text will
be filled into the text box automatically.

Automatically From Other Applications

See Automatically Pasting Verses into Another Application .

173

88

93



Copying and Exporting Text 93

© 2015 StudyLamp Software LLC

5.3 Automatically Pasting Verses into Other Applications

While SwordSearcher is running in the background, pressing Ctrl+Alt+V will open
SwordSearcher's Copy Verses dialog , then automatically paste the selected verses into
the application with the Windows clipboard.

For example, while SwordSearcher is running, run MS Word and open a new document.
While editing in MS Word, type Ctrl+Alt+V (all at the same time). SwordSearcher
becomes active and the Copy Verses dialog is visible. Type a verse reference, such as Joh

3:16, then press Enter. MS Word now becomes active again, and SwordSearcher

automatically sends the paste command to MS Word and the verse is now part of your
document.

Notes and limitations

SwordSearcher must be running for the Ctrl+Alt+V hotkey to work.

The hotkey will not work in SwordSearcher if another application has already "hooked"
the Ctrl+Alt+V hotkey to a function.

The application you are working in must support the standard Ctrl+V command for
pasting from the Windows clipboard in order for the verse(s) to be automatically pasted.

Not all applications are compatible with this feature.

This function can be disabled in Preferences .

5.4 Copying Book and Commentary Entries to the Clipboard

To copy a range of entries from a book or a commentary, first make the book or
commentary you want copied active by clicking on its tab in the Book  or Commentary

 panel. Then select the appropriate option from the Edit menu: Copy Range of
Comments copies a range of verse commentary text from the active commentary, and
Copy Range of Book Entries copies one or more entries from the active Book or
Dictionary.

If you just want to copy the visible text from the Book or Commentary panels, right-click
the panel and select Copy All.

5.5 Printing Verses

Printing verses is the same as copying verses to the clipboard with the Copy Verses
dialog, except they go to a printer instead of the clipboard.

Select Print Verses from the File menu, then follow the same steps for using the Copy
Verses dialog .

5.6 Printing Book and Commentary Entries

To print a range of entries from a book or a commentary, first make the book or
commentary you want printed active by clicking on its tab in the Book or Commentary
panel. Then select the appropriate option from the File menu: Print Range of Comments
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prints a range of verse commentary text from the active commentary, and Print Range of
Book Entries prints one or more entries from the active Book or Dictionary.

Usually, you will just want to print one entry. The best way to do this is to make the
Book or Commentary entry you wish to print active in the Book or Commentary panel,
and then select File > Print Book/Commentary Panel Text. This is especially handy for
printing out a personal book module entry to be used as a Bible study handout.
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6 Module Sets

In SwordSearcher, Library items (books, commentaries, Bibles, etc) are called Modules.
Due to the large volume of modules available for SwordSearcher it can be very helpful to
create groups of them, called Module Sets. You can create as many module sets as you
desire to organize your library. Module Sets are not something you need to use to get the
most out of SwordSearcher, but they can be very useful if you find that you often wish to
switch between different groups of visible tabs or Bible margin links.

There are three areas in SwordSearcher that can use Module Sets:

1.Visible Library Tabs
2.Bible Margin Links
3.The Full Library Search

Creating and Editing Module Sets

To create and edit module sets, select Configure Module Sets from the User menu:

Sample showing Configure Module Sets on the User menu

The Module Sets dialog window will appear:
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On the left is the list of your module sets, which will initially be empty. Click the New
button to create a new module set and give it a name. As an example, the above shows a
module set named "Favorite Tabs" which was created with the intent to list the user's
most often used library tabs. On the right, you can select which modules you want to be
included in the selected Module Set. Use the title filter to quickly find a module by typing
part of its title or abbreviation.

Controlling Tabs or Margin Links with a Module Set

You can use module sets to control the Visible Library and/or Bible Margin Links. 
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When you use a Module Set to control the visible library tabs, you can still open new tabs
with the Module Selector , with links in the Bible panel, etc.

Also, when a Module Set is used to control the Bible Margin links, the Bible panel can still
have the margin area toggled off, or even have entire categories of links disabled with
the Bible panel toolbar.

See also Managing Library Tabs  and Bible Panel  (margin).

When you are not using a Module Set to control tabs or Bible margin links, these settings
are instead controlled in the Preferences and Settings  window.

If you use a Module Set to control your visible library tabs, it is important to remember
that if you install a new module (such as from a download), its tab will be hidden unless
you add it to the Module Set.

Using a Module Set to Narrow a Library Search

The Full Library Search  tool allows you to narrow your search to a select group of
modules.
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Including/excluding a module in sets from its tab

A quick way to change which Module Sets a module is part of is to right-click its library
tab and select the "... in Module Sets" option:
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You can then select which module sets the module should appear in:

This can also be done from the Module Selector  right-click menu.63
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7 The Image Viewer

SwordSearcher includes hundreds of illustrations, maps and charts. These are viewed
with the Image Viewer.

Certain modules (such as the Easton Bible Dictionary) have links to illustrations which
you will see while reading entries. For example, the Easton's Bible Dictionary entry for
Tabernacle has two illustrations. Clicking the illustration links within the entry will open
the illustration in the Image Viewer. (Note that the evaluation download of
SwordSearcher does not include any illustrations due to file size constraints.) Following
this example, you would see this:

Sample Image Viewer for Easton: Tabernacle in the Wilderness

If you have a Microsoft IntelliMouse (or compatible mouse with a scroll wheel), you can
use the mouse wheel to zoom in an out on the image. The zoom control at the bottom of
the window also zooms in and out on the image. For images that are larger than the
display area, you can drag the image around by clicking and holding the left mouse
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button and dragging, or by using the scroll bars on the display.

The Image Viewer automatically fits large images to the display area as needed.  If an
image appears too small to read, you can usually "zoom in" to inspect detail.  After
zooming, you can return the image to "fitted size" by right-clicking on the image and
selecting "Smart Fit."

The High Quality Resize option at the bottom of the window controls how sharp images
look when they are zoomed out (made smaller).  The High quality resize function is very
effective but may adversely impact responsiveness on older computers.  If images take
too long to show or the Image Viewer appears sluggish, you may disable this function to
speed things up at the cost of image fidelity.

Images in the Image Viewer can be copied to the clipboard or printed with the tool bar
functions.
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8 Devotional Functions

(See also the next topic, Reading Schedules .)

Morning and Evening Daily Devotional

SwordSearcher includes C.H. Spurgeon's Morning and Evening daily devotional readings.

The actual devotional text is included as a commentary module (SME in the Commentary
panel ). To access a specific reading, use the Devotional menu.

Selecting This Morning would move the Bible panel and the Commentary panel to the
current day's morning readings. Selecting This Evening would do the same for the
evening readings.

Selecting Select a Day/Time allows you to access a different day's readings.

Daily Proverb

The book of Proverbs has 31 chapters, which means that reading a chapter a day is a
convenient means of keeping your mind on spiritual knowledge.

To quickly move the Bible panel to the current reading, select Today's Proverb from the
Devotional menu.

You can also have SwordSearcher automatically open the current reading on startup by
configuring the Startup Verse option in Preferences .
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9 Reading Schedules

SwordSearcher includes a flexible daily Bible reading schedule system. You can have as
many active reading plans as you want, and SwordSearcher will help you stay on-track
with your daily Bible reading commitment.

Use the Devotional main menu to access the reading schedule functions, or click the
reading schedule button on the main toolbar to open the Reading Schedule window.

Using the Reading Schedule

· Create a Reading Plan
Start a reading plan to take you through the Bible in a year, or design a custom
reading plan  for your individual needs.

· The Reading Schedule Window
This calendar-based schedule is where you do your daily reading. From here you can
also access the auto-reschedule function if you fall behind on your reading plans and it
would be too difficult to catch up.

· The Reading Schedule Manager
Reschedule, rename, delete, print, and more.

The reading schedule functions of SwordSearcher prominently feature estimated
reading times and use them for calculating plans. This is far more useful than dividing
readings only by verses or chapters. Also, including the reading time in the calendar
makes finding the right time to sit down for your daily readings much easier, since you
have a very good idea of exactly how long it will take.

Falling behind on your schedule doesn't mean giving up! SwordSearcher can instantly
reschedule your plans if catching up would be too difficult.

About estimated reading times: Reading times are based on Alexander Scourby's
narration of the King James Bible, and are a good gauge of the time required to read
verses in a natural, narrative manner.

The Reading Schedule Toolbar Button

Reading Schedule main toolbar button

The Reading Schedule toolbar button appears as above if you do not have any active
reading plans.

104

107

114

116



SwordSearcher 7104

© 2015 StudyLamp Software LLC

When you do have active plans, this button has three states to help you stay on track
with your reading schedule:

Behind:
There are unread items

from previous days.

Unread items today:
You are not behind, but

there are unread item's in
today's schedule.

Up-to-date:
You are completely caught
up with no unread items

today.

Reading Plan Suggestions

A standard Bible in a Year plan is a great way to get consistent time in Scripture. While
reading through the Bible may seem like a daunting goal, the reality is that it can be
done in one year with an average reading time of 12 minutes a day. Use the standard,
preset Bible in a Year plan to do this. With this plan you will read from the Old Testament
and New Testament every day.  Set aside 15 to 20 minutes a day for the reading and
impromptu study.

Take your study commitment to the next level, and set up a short daily reading plan in
addition to your annual plan. Use this short plan as a starting point for daily study. The
custom reading plan designer can create plans that are as short as five minutes a day, so
try that. For example, create a plan to read through the book of Galatians in five minute
daily portions. This only takes four days! Read the planned portion of Galatians on each
day (five minutes) and then spend another five minutes searching various interesting
words from that reading, comparing Scripture with Scripture. Use the TSK module as a
cross-referencing guide (see this web post for guidance on using the TSK). Warning: you
may find your "five minutes" quickly turns into half an hour of time learning wonderful
doctrine!

Reading Plan Data File

All of your reading plan data is stored in your Documents\SwordSearcher User Modules

folder. Be sure to include this folder in your normal backup routine. Most backup software
should automatically include this location.

9.1 Creating a Reading Plan

To add a new reading plan to your schedule, select Add a New Reading Plan to the
Schedule from the Devotional menu.

http://www.swordsearcher.com/blog/how-to-use-the-treasury-of-scripture-knowledge/44/
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Sample Devotional Menu

There are two ways to add a reading plan. You may schedule a Standard "Bible in a
Year" plan, or, you can Design a Custom Reading Plan.

Sample of the Create a Reading Plan window

Standard Bible in a Year Plan

The Standard Bible in a Year plan will take you through the entire Bible in a year, reading
from the Old and New Testaments each day. This plan averages 12 minutes a day for
reading.
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To begin a "Bible in a Year" plan, select the Standard Bible in a Year Plan option, then
click Next.

On the next page you can see a preview of the daily readings in the plan. Click Next.

On the final page, you can give your reading plan a unique title, and select a beginning
or ending date of the plan. By default, the plan will be scheduled to begin today. It's easy
to select a different starting date for the plan under First Day of Plan.

Click Save, and you're done! Your annual Bible plan is now scheduled and you can start
reading the daily items.

Designing a Custom Plan

Want to read Acts by Friday? Or how about the five books of Moses before the end of
next month?

Or do you want to spend 5 minutes reading from the Gospels every day?

Easy! Let SwordSearcher help you design a custom reading plan to suit your needs.

See Designing Custom Reading Plans  for a walk-through.

Using a Previously Designed Custom Reading Plan Again

If you have a plan you want to schedule again, that's easy to do. Just choose the
"Previously Designed Custom Plan" option and you can start a new schedule with new
dates.

Advanced users: Importing Templates

If you have a SwordSearcher reading plan template file from another SwordSearcher
user, you can click the Import Template from File to load the plan template and schedule
it. Templates can be exported from the Reading Schedule Manager  and shared with
other SwordSearcher users.

Advanced users: Importing custom reading plans you design
outside of SwordSearcher

If you need to schedule a reading plan that can't be designed in SwordSearcher, such as
a plan provided to you by your church, you can use a plain text file containing daily
readings on each line, and the plan will be added to your schedule. Use the Import
Template from File button and change the file type to "Daily Reading Per Line Text Files
(*.txt)", and select your file.  SwordSearcher will build your plan from the list of readings
and inform you of the plan coverage so you can be sure it was properly imported.  As an
example, here is a four-day plan for reading Genesis and Matthew, with readings from
each book on each day:

Gen 1-12; Mat 1-7
Gen 13-24; Mat 8-14
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Gen 25-36; Mat 15-21
Gen 37-50; Mat 22-28

9.1.1 Designing Custom Reading Plans

The real power of SwordSearcher's reading schedule system is the ability to design
custom reading plans. If you want to go through the Gospels in two weeks, or read the
Psalms in a month, it's easy to set up a reading schedule to do just that. You can create
as many custom plans as you want.

On the Devotional menu, select Add a New Reading Plan to the Schedule. 

Step 1 of designing a custom reading plan

To get started, choose Design a Custom Plan and then click Next.

Time
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Step 2 of designing a custom reading plan

The next step is to decide how the duration of the plan will be determined.

Option 1: Daily time allotment. You can base the plan on how much time you want to
spend on it each day. From an easy 5 minutes per day to an ambitious 2 hours per day,
the readings will be divided to give you a fairly consistent daily reading time. Rather than
just "chopping up" the readings by verse count, SwordSearcher will base the daily
portions mainly on how long they will take to read. This type of plan favors consistent
daily reading times, but still tries to begin and stop daily readings at logical points in the
text.

Option 2: Calendar days. This option bases the plan on a fixed calendar period. For
example, you may wish to read through the whole Bible in three months, or the Pauline
Epistles in one month. Use the date selectors to help you choose the number of days, or,
use the Preset Length menu to automatically choose from a list of predefined plan
lengths (one week, one month, etc.) If you have a specific ending date in mind for your
reading plan (e.g., "I want to read the book of Acts by Friday"), you can use the date
selectors to specify the required length of time.

The actual scheduling of your reading plan (where you choose exactly when to start the
plan) will come in the final step.  For now, you are just designing a plan that can be re-
used any time you want, and the first/last days shown in this step are just examples.

About daily reading division: SwordSearcher doesn't just chop up reading plans by
verse count. SwordSearcher's reading plan system intelligently uses the time required to
read each verse and chapter to create a more consistent daily reading plan, and when
possible, starts daily readings at logical positions in the text instead of merely dividing by
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verse count.

Once you make your choice, click Next. Don't worry. You can always use the Back
button to come back to the step if you change your mind before you're finished making
the plan.

Scripture

Step 3 of designing a custom reading plan

The next step is to assign scripture segments to the plan. Type a range of verses (usually
books, like Mat-Joh) and then click Add to Plan to add it to the list of assigned reading
segments.

Here is a simple example. If you want to read through the Gospels in one month, you
would assign a single reading segment like this:
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Leave the reading count set to "read once", then click "Add to Plan."

At this point the plan could be complete and you would click Next. But what if you want
more in the plan?

A scripture segment is a range of verses from which you want to read every day. For
example, a plan that reads through the entire Bible once in book order has a single
scripture segment: Genesis through Revelation. If you want to read from multiple
segments on each day, you would assign two or more segments. For example, you can
create a plan that goes through Psalms and the Gospels, reading from Psalms every day
and the Gospels every day, by assigning two segments. In the above example, we
already have the Gospels in our plan, so we can just add Psalms.

Also, let's say that by the end of the month we want to read through the Psalms twice.
Meaning, we want to read through the Gospels in a month, and Psalms twice in a month,
from both each day. To do that, we add a segment for Psalms and use "Read Twice"
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instead of Read Once.

(Again, just type the name of the book in the Passage box, or use the drop-down menu
to add it without typing.) 

Tip: Remember, reading segments are used to specify portions of Scripture that you
want to read from every day. Don't add books as separate segments unless you want
to read from them every day. To specify a range or groups of books to read through
in order you just need to use a single reading segment with those books.  For
example, you can read Acts, Ephesians, and Jude by adding a single reading segment
with the passage "Acts; Ephesians; Jude".

Lets continue with our above example. We have specified that we want to read through
the Gospels (Mt-Joh) every day, and the Psalms every day. By the time the plan is
completed we will have read through the Gospels once and the Psalms twice.

Click Next. 

Preview

Assuming we chose one month for our plan duration, we should see a preview like this:
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Step 4 of designing a custom plan: the preview.

As we can see, our plan will take 30 days and average 32 minutes of reading each day.
The plan preview shows you exactly how the plan is divided over the days. With a plan
like this one, with plenty of reading material each day, the division of the plan strongly
favors chapter positions and never stops in the middle of a paragraph.

If you aren't satisfied with the plan, you can use the Back button to make changes to the
reading segments or the duration of the plan. Experiment until you are happy with the
results.

Click Next.

Schedule and Save
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Step 5 of designing a custom reading plan

Now you're ready to give the plan a title and schedule it. In the above example we're
using the title "Gospel and Psalms in a Month," and the plan will start on March 4th,
2014. We can see that the last day of the plan will be April 2nd. You can choose one or
the other: a beginning or ending day of the plan.

When you're happy with the schedule and title, click Save.

Done!

Now that our plan is scheduled, we can start reading the first day, which looks like this in
the Reading Schedule:
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Sample Reading Schedule Window

9.2 The Reading Schedule Window

To open the Reading Schedule, click the Reading Schedule button on the toolbar (or use
the Devotional main menu).

Reading Schedule main toolbar button

This is what the Reading Schedule looks like:
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Sample Reading Schedule window

When you are up-to-date, you can easily read ahead

It's easy to use the calendar control at the top to skip ahead, but there is a shortcut
when you are caught up:

(This option appears when you are up to date.)

If you fall behind, it's easy to reschedule your plans



SwordSearcher 7116

© 2015 StudyLamp Software LLC

It can happen! Don't give up on your reading commitments if you fall behind.  The best
thing to do is to catch up -- double-up on your daily reading until you are all caught up.
But if that would be too difficult, you can reschedule your plans in one easy step:

(This option is only enabled if you are behind on your
schedule.)

When you click the auto reschedule button, each plan will be rescheduled so that the first
unread day is today. You'll see a confirmation prompt informing you of the changes that
will be made to each plan before proceeding.

· Only plans on which you are behind will be changed.
· Plans are rescheduled, not automatically "marked read." This function does not skip

any readings.

Other shortcut buttons

Add a new plan is a shortcut to Create a Reading Plan  and add it to the schedule.

Open the Reading Schedule Manager is a shortcut to the Reading Schedule Manager ,
where you can print, rename, delete, and perform other tasks.

Go to Current is a shortcut to the current day of the schedule, or the first unread day (if
you are behind). This is only enabled if you are viewing a different day in the plan, which
can be done using the calendar control at the top of the window.

9.3 Reading Schedule Manager

The Reading Schedule Manager is where you can print, rename, delete, and reschedule
plans. This is not where you do your daily reading. Use the Reading Schedule window
to do your daily readings.

Open the Reading Schedule Manager from the Devotional menu. It looks like this:
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Sample Reading Schedule Manager window

Plans and Templates

Under "Plans and Templates" you can see your plans.

Active Plans are any plans that you have scheduled and not completed. Completed Plans
are plans for which you have completed all of the daily readings. Templates from Custom
Plans are "unscheduled" plan templates that are created any time you make a custom
reading plan .

Click on a plan under Plans and Templates to see its details in the plan details area.

Plan Details

The details area shows you the complete plan. In addition to reviewing the plan, you can
change the completion state of a day or reading anywhere in the plan. 

107
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Right-click a day, or an individual reading, for handy options:

Plan details right-click menu

Changes you make in the plan details area are saved immediately.

With a plan selected, the Plan Options button brings up the following options:

Plan options

Use Reschedule This Plan to manually reschedule the plan with a new starting or ending
date. This can also be used to automatically reschedule the plan so that you are not
behind. In either case, your completed readings will be remembered. Only the starting
date of the plan is changed.

Rename and Delete are self-explanatory. Deleting a plan is permanent and cannot be
undone.

If you want to suspend a reading plan and remove it from your daily reading schedule,
select Deactivate Plan. Deactivated plans retain your progress and can be re-activated or
re-scheduled when you wish.

Print Plan prints the entire plan including its current state -- with check boxes filled in for
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completed readings, and empty check boxes for readings that have not been completed.
If you print a template, the printout will not include specific dates and all of the check
boxes will be empty.

Printing your reading schedule

Printing the Schedule

You can print your reading schedule, which includes all of the active plans.

The main purpose of this function is to allow you to continue reading from your schedule
for an extended time away from your computer. For example, if you are going on
vacation for a week, you can print your schedule to continue reading from your printed
Bible while you are gone. Then when you return, you can use the Reading Schedule
Manager to reconcile your plans by marking days read in the details area.

Saving a Plan Template File

If you have created a custom reading plan, an "empty" unscheduled version of your plan
is available as a "template" so that you can quickly schedule the plan again in the future.
Additionally, you can export custom plans to a template file using the Plan Options menu.
Select the template from the Plans and Templates area at the top, and then click the Plan
Options menu to Save Template to File. This file can be shared with other SwordSearcher
users and does not contain your schedule or days read; it only contains the plan itself.

Templates can be imported and used by other SwordSearcher users in the first step of
the Create a Reading Plan  window.

Templates from custom plans you have created are automatically available in the Create
a Reading Plan window -- you do not need to save a template file unless you want to
send it to another user.

104
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10 Using Bookmarks

SwordSearcher's bookmark system allows you to bookmark Bible verses, book entries,
and commentary entries. You may set a total of ten bookmarks at a time.

Note: If you wish to maintain a topical list of "bookmarks" or more than ten references, 
creating a user Book module  to contain topical information and links is a better choice
than the bookmark system.

Setting a Bookmark

The Bible, Book, and Commentary panels in SwordSearcher each have a pop-up menu
item for setting a bookmark. For example, in the Bible panel, right-click a verse you wish
to bookmark and select the Set Bookmark to > item, which will open a submenu. Select
the bookmark you want placed. If you select a bookmark which is already placed, it will
be reset to the new location. Here is a visual example of setting a bookmark on a Bible
verse:

Setting a bookmark to a verse in the Bible panel

122
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You can also set bookmarks from the Bookmarks menu on the main menu.

Viewing Bookmarks

View bookmarks and go to their places with the Bookmarks menu on the main menu.
Also, you can use Ctrl+1 through Ctrl+0 on your keyboard to go to the bookmarked
material.

Clearing Bookmarks

If you wish to erase a bookmark or all bookmarks, select Clear Bookmark on the
Bookmark menu. You do not need to clear a bookmark before setting it to a new location.

Keyboard Shortcuts for Bookmarks

To go to a placed bookmark with the keyboard, press Ctrl+ the number of the bookmark.
E.g. Ctrl+1 for bookmark #1 and Ctrl+0 for bookmark #10. To set a bookmark, press
Shift+Ctrl+ the number of the bookmark you wish set.

Setting Titles for Bookmarks

Optionally, you can configure titles for your bookmarks.  For example, you can call a
bookmark "my son's memory verse" and that title will stay with the bookmark even when
you change where the bookmark is placed.  This is an optional feature and is not
necessary to use bookmarks, but can be helpful if you make extensive use of bookmarks
and have a hard time remembering what each one is used for.

To set or change bookmark titles, select Bookmark Titles from the main Bookmarks
menu.
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11 Creating Your Own Books and Commentaries

SwordSearcher makes it possible to create your own Book and Commentary modules,
which are fully indexed and searchable as part of your library. User Books are especially
useful for recording your own topical studies, and many users will find them useful for
the preparation and storage of Bible lessons and sermons.

(If you have user modules from SwordSearcher 3.x or 4.x, you can easily import them for use in this version
of SwordSearcher. See Importing Modules from Previous Versions .)

Creating a User Module

Select Create New User Book or Create New User Commentary from the User menu.

Sample of SwordSearcher's User menu

If you're not sure what the difference between a user Book and a user Commentary
would be, review the help topics on Book panels  and Commentary panels .

Selecting Create New User Book brings up the new user module dialog:

138
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Sample New User Book dialog

Specify the name and abbreviation for the new book module. You can not use a name or
abbreviation that is used elsewhere in SwordSearcher. Also, the abbreviation must be
nine characters or less long.

Click OK and new module will be created.

Adding and Editing Entries in User Book Modules

Once you've created a book module, you can add entries to it with the Add New Entry
button on the Book panel toolbar. (Make sure your module is selected.) Step-by-step:

Creating a new book entry
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Once your entry is created, you can edit or delete it with appropriate toolbar buttons.

Book panel buttons for editing user entries

Clicking the Edit Entry button opens the Editor  for the active entry.

Tip: if you want to create a lot of empty entries at one time from a list, click Add multiple
entries after clicking the Add New Entry button.

The User menu has functions for deleting or renaming user book modules.

Editing Entries in User Commentary Modules

Once you've created a commentary module (with Create User Commentary on the User
menu), there is no need to "create" an entry for a verse comment. They are created
automatically as needed when you start editing a verse comment.

There are two ways to edit a comment on a verse in your commentary.

1. After you've created your User Commentary module, the margin area in the Bible
panel  includes links to edit your commentary on each verse:

Edit commentary link in Bible panel

2. Or, select your commentary, type (and press Enter) or select the verse you want to
edit commentary on, and click the edit button:

125
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Editing a commentary entry with the commentary panel

(You can also use a favorite commentary widget  in the Bible panel.)

Either method will open the Editor  for the comment you wish to edit.

The Delete Active Entry button erases the text of the selected entry, if any.

Once you have edited comment text for a verse, a link to that text is shown next to the
verse in the margin of Bible panel , just as with any of the other commentary modules.

The User menu has functions for deleting or renaming user commentary modules. The
Book and Commentary menus also have these functions for the active modules in the
respective panels.

11.1 Using the Editor

SwordSearcher includes an editor for editing content in user library modules. See 
Creating Your Own Books and Commentaries  for details on how to initiate editing a
user entry.
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Sample editor window, showing user editing comment text on 2Ti 3:16.

The editor is a word-processor style editor and provides several formatting options. You
can use the common Windows clipboard commands Copy, Cut and Paste as you would in
any text editor. Experiment with the toolbar buttons and review the Format menu to see
what kinds of formatting options you may apply to your text.

Any verse references you type in the text will be automatically linked when the entry
is displayed in the Book or Commentary panels, and indexed for the Verse Guide . See
Verse Links and Links to Other modules in the User Editor  for more information on
links in user entries.

Advanced users with a strong understanding of HTML code may also want to use the
editor in "code edit mode ."

Editor Functionality

Find and Replace functions are on the editor Search menu. Once a find operation is
executed, you can repeat it with F3.

You can paste images in from the clipboard or use the Insert Image function on the
toolbar (or Insert menu).

Tables are also supported. Use the Insert Table button on the toolbar (or Insert menu) to

27
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insert an empty table. Right-click a table to add, remove, and merge cells, rows, and
columns.

The editor has an integrated spell check which checks spelling as you type, and
underlines words in red that are not found in the spell check dictionary. Select Spell
Check Options from the Spelling menu to change settings for the spell checker or disable
automatic spell check. You can initiate the spell check manually with F7 or on the
Spelling menu. The integrated spell check understands American English and all of the
words found in the King James Bible. A British English dictionary is also available and can
be selected in spell check settings.

When pasting in text from other sources, it is often useful to use the Remove
Formatting function on the pasted text. Mark the text you wish to "normalize" and then
click the Remove Formatting button on the toolbar or Format menu to remove font and
other formatting. A similar command on the Format menu is Remove Link, which is
helpful when you paste in text from a website that may contain links to other documents
that you don't want retained in your entry. Another useful function is Paste As Plain
Text, which pastes text from the Windows clipboard without retaining the source
formatting options.

If your entry contains a large amount of inconsistent or undesired formatting, which can
happen when pasting text in from external sources, use the Style and Format Cleaner
tool (on the Format menu) to "scrub" the text free of formatting. The Style and Format
Cleaner provides options for choosing what kind of formatting to retain.

If you are having trouble editing around a line break or paragraph, you can use the 
Show HTML Element Tags setting on the Edit menu to make certain non-visible
elements visible as icons in the editor.

Pressing Enter while typing text inserts a new paragraph. Because entries are at their
core HTML documents, paragraphs are "HTML style" paragraphs with white space
separating them. To insert a line break without creating a new paragraph, press Shift
+Enter.

Inserting Text for Verses

If you are using the editor to create Bible study handouts or sermon notes, it can be
helpful to insert the complete text of Scripture references directly into the document,
rather than relying only on verses being linked in the display panels. This way, the
complete text of the verses is included when you print the entry.

Using the Insert Text for Verse References at Cursor function does this automatically.
This function is on the Insert menu but can also be accessed by pressing Ctrl+T. Type
verse references or move the typing cursor into already typed verse references and press
Ctrl+T:
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Verse references are typed...
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...and after Ctrl+T is pressed, text is inserted automatically.

The formatting used for the verse references and verse text can be configured in the
main Export Formatting  dialog.

11.1.1 Verse Links and Links to Other Resources in User Entries

The User Editor  includes several helper functions for inserting links in user book and
commentary entries.

Verse references are automatically linked

Verse references you type in the user editor are automatically linked in the Book or
Commentary panels, and also indexed for use in the Verse Guide . (The links only
appear in the Book and Commentary panels after you save the entry. They are not linked
in the editor itself.)

For example:
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This user entry has two verse references typed.
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The Commentary and Book panels show the verse references as links.

When you have trouble getting a verse reference to link

First, make sure that you are typing in at least a book name and chapter number. In
order to avoid incorrectly linking a verse, SwordSearcher will only link complete
references that have a book name (or abbreviation) and at least a chapter number. 
SwordSearcher can understand over 2,000 different forms of names of the 66 book
canon, but if you are unsure how to specify a book you can check the Book Abbreviations

 appendix.

If you are unsure of the correct way to write a verse reference, you can use the Link to
Verse(s) function on the editor Insert menu to preview verse references and have them
standardized and inserted into the editor for you. Also, the Bible and Verse List panel
right-click menus have functions for sending links to the user editor.

If you enter some references and SwordSearcher incorrectly identifies them, or
incorrectly recognizes a number at the start of a proceeding sentence as a verse, you can
surround your verse references with # symbols to tell the editor when a verse reference
begins and/or ends.

173
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For example, this sentence:

1. See Joh 1:1,3. 2. See Joh 2:1.

is ambiguous because the "2." looks like a chapter reference.  The above could be re-
written like this:

1. See #Joh 1:1,3#. 2. See #Joh 2:1#.

The # symbols will tell the editor to "break" at that position and "start over" looking for
verses, so the following number is not included as a part of the preceding list of verses. 
The # symbols are hidden during display so they don't appear in the Book and
Commentary panels; only in the editor.

Note that you should not usually need to use # symbols. SwordSearcher will almost
always "figure out" what verse references are intended.

Also check the Configure Verse Reference Recognition (editor File menu) to ensure that a
specific abbreviation you are using is not excluded from Bible book name interpretation.

Telling the editor not to link a verse reference

If SwordSearcher is linking verse references that you do not wish to be shown as links in
the Book or Commentary panel, just surround the reference(s) with / symbols like this:

This verse reference won't be linked: /Joh 1:1/.

The / symbols will be hidden in the Book and Commentary panels and only appear in the
editor itself.

If SwordSearcher links text it shouldn't: In the Editor, select the File menu and
choose Configure Verse Reference Recognition. You can add words that should not be
interpreted as a Bible book name, and disable Roman number recognition if you do not
need it.

Linking to other entries in your module

Use the Insert menu item Link to Entry in this Module to insert a link to another entry in
the Book or Commentary you are currently editing. (This is a good idea because the link
will continue to work even if you change the name of your module.)

Linking to other modules in SwordSearcher

If you want to link to an entry in a different Book or Commentary, use the Link to an
Entry in Book or Commentary function. You can also right-click the Book or Commentary
panel to send a link to the visible entry to the editor.

To link to an image in the SwordSearcher image viewer, open the image in the viewer
and right-click it and select Send Image Link to Editor.
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You can also insert links to "searches" -- these types of links will perform a Bible, Book,
or Commentary search for the specified search expression. Link to a Bible Search, Link to
a Book Search, and Link to a Commentary Search are on the editor Insert menu. Search
links support SwordSearcher's advanced search expressions .

Advanced users: SwordSearcher URL Protocol and the Code Editor

Users who are familiar with HTML code can use the editor in "code edit mode" and create
various links to other SwordSearcher modules and common actions manually with <a

href="swordsearcher://...">...</a> links. See Using the Code Editor  and the URL

Protocol  appendix.

In addition to the SwordSearcher URL protocol, you can specify an in-line image link
which uses an image from the SwordSearcher Image Viewer this way:

<img src="{ssimagestorepath}\Maps\Kingdom of Saul.png" width="90%"/>

{ssimagestorepath} is an in-line variable to the SwordSearcher image store which is
automatically expanded during display in the Book or Commentary panel.

11.1.2 Bible Study and Sermon Preparation in User Books

A user-created Book module is the ideal place to store, create, and edit Bible study
guides, handouts, and sermon notes.

For example, you could create a user Book  module called "BibStudy" to hold all of
your Bible study class handouts. Don't create a new book for each Bible study -- instead,
create new entries in the BibStudy module for each study. Not only is SwordSearcher the
perfect environment for building Bible studies and sermon notes, it is also very handy to
have all of your past notes in SwordSearcher and completely indexed for the Verse Guide

 and Topic Guide , and they can be instantly searched.

To print an entry as a handout, just make the entry visible in the Book or Commentary
panel, then right-click the panel and select "Print this window."  You can tell
SwordSearcher how many copies to print.  (Alternatively, you can use the appropriate
Print item on the File menu.)

Tips for creating Bible study handouts

When you create an entry in a user book, SwordSearcher automatically links verse
references in the entry text.  This is perfect for when you are using SwordSearcher, but
mere links are less than ideal when you want to print the entry to use as a handout.

The user editor has the ideal feature for just this case: The Insert Text for Verse
References at Cursor  function (Ctrl+T). All you have to do is type a verse reference
and then press Ctrl+T, and the text of the verse(s) is inserted directly into the entry. This
way, when you print it out, the complete text of the reference is right there on the page.

11.1.3 Using the Code Editor

Advanced users with a strong understanding of HTML code can directly edit the source
code of user module entries.
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If you do not have experience editing HTML code, do not use the code editor.
Instead, use the default "Design" editor which works like a word processor.

Users who have no intention of directly editing HTML code should skip this
section.

The Code Editor

The code editor can be selected in the user editor by clicking the "Code" tab at the
bottom of the editor window (or selecting Code Edit Mode on the Edit menu).

Sample user editor window in code edit mode

The code editor provides little more than syntax highlighting. Most features present in
Design mode are not available in code mode. Review the menu items to see which ones
are enabled during code edit mode.

Verse references are still linked automatically by SwordSearcher even when you save an
entry in code edit mode.

SwordSearcher module entries are HTML documents.  It is important to create accurate
HTML source when using code edit mode.  A discussion of HTML itself is beyond the scope
of this text.

Do not use external linked CSS files in your HTML code.  If you want to use style sheets,
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they must appear in the <head> section of each individual entry.

SwordSearcher's Book and Commentary panel displays support HTML 4.01 and CSS Level
1. Additionally, if you have Internet Explorer 8.0 or later installed, CSS 2.1 is also
supported.

Note that you can switch between Design and Code modes on-the-fly.  However, the
Design editor will rewrite your HTML source code and change formatting to suit its own
tastes!

Generally, the code editor should only be used to make minor tweaks or to insert
elements not formally supported by the Design editor. Some users may also find editing
code in a separate, dedicated HTML editor more convenient. You can easily paste in HTML
code from other sources into the SwordSearcher code editor.

Users who use the code editor may also be interested in Forge , an external
SwordSearcher module build tool.

11.2 User Module Storage and Sharing

User module files are stored in your Windows documents folder. The exact name of this
folder depends on your Windows configuration, but is usually Documents\SwordSearcher

User Modules. Backing up and restoring user modules is as simple as copying all of the

files in this directory.

If you have backup software, this folder will probably be backed up automatically. Just
make sure the folder is included in your backup routine, and you should be able to
restore your user modules at a later time.

When you delete a user module with one of the delete functions on the User menu, the
module file is moved to the Windows recycle bin. If you delete a user module in error,
close SwordSearcher, then use the recycle bin's restore function. The file name is your
module's abbreviation and "ss5book" or "ss5cmty."

User modules that contain images added in the editor will also have an "assets folder" in
this location, where local copies of the images are stored. Do not remove or rename
assets folders. If you want to rename or delete a module, use the appropriate function on
the User main menu.

Bible panel highlighting and underlining  data is also stored in this location, as well as
your Reading Schedule  data.

Advanced users who want more control over user module file storage can add additional 
Module File Locations in Preferences  or even remove the default location.

Sharing Your User Modules and Third-Party Content

It's very easy to share your user modules with other SwordSearcher users. All you need
to give them is your user module file from My Documents\SwordSearcher User Modules. For

example, if your user commentary is called Stan's Notes and the short (abbreviation)
title is Stan, you would find
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Documents\SwordSearcher User Modules\Stan.ss5cmty

and send a copy of it to another SwordSearcher user. If your module contains images
added in the editor, you also need to include the associated Assets folder.

Tip: you can use the zip function of the Advanced User Module Maintenance  window
to quickly zip up a user module for sharing, including any necessary assets (image) files.

To install someone else's user module on your system, make sure SwordSearcher is
closed, and put it into your own user modules folder, like the above. If the module was in
a zip file, you need to extract the files from the zip file here.

If you are intending to share your user modules with other users, it is important to use a
unique title, especially the abbreviation. Using MyNotes is a bad idea, because many
others will already have a file with that title. Also, if you are installing someone else's
module, make sure you do not accidentally erase one of your own if it has the same
name.

No warranty or support can be provided for third-party modules. The publishers of
SwordSearcher have no control over what content users may share. You download and
use third-party content at your own risk.

If you have made your own content available online and would like to tell others about it,
feel free to announce it on the SwordSearcher User Forums.

Technical note: Module Compatibility

SwordSearcher 7.x is backwards-compatible with 6.x and 5.x user module files, with the following exception:
SwordSearcher 6.0 and later fully supports Unicode text in user-created modules. If you create or edit a user
module and use any non-ASCII text, the resulting module file will not display properly in versions prior to 6.0.

11.3 Exporting and Printing User Content

When you create your own Books and Commentaries in SwordSearcher, your content is
not "captive" to SwordSearcher.

Printing your user Book or Commentary

To print just one entry, such as for a Bible study handout: Make the entry visible on
the Book or Commentary panel, then right-click the panel and select Print This Window.
(Alternatively, you can select the corresponding Print function on the main File menu.)
You will be prompted to specify how many copies you wish to print and what printer to
use.

To print your entire Book or Commentary: Use the Print Entire User Book/
Commentary items on the main SwordSearcher User menu.

Exporting your user Book or Commentary

If you need to get your Book or Commentary into an external file, you can use the Export
functions in the Advanced User Module Maintenance  window.
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11.4 Advanced User Module Maintenance

Advanced User Module Maintenance is available on the User main menu.

Most SwordSearcher users will not need this tool. It is designed primarily for module
authors with complex needs. The tools in this window only apply to user-editable
modules.

The Module Maintenance window has five sections:

Export

From here you can export your user module to one of two formats:

Export Module as HTML Document: Writes the entire module content out to an HTML
document that can be loaded by most word processors or by a web browser.

Export Module for Forge: Saves the module content to the Forge input file format.
Advanced users with complex processing needs can use this file and rebuild the module
with Forge for SwordSearcher .

Assets

Images for user module entries are considered assets and stored in a companion folder
with the module file. The tools on this page of the Maintenance window are used to
ensure that the module does not have any "external" image references not owned by the
module. Images from entries which are on web pages or other locations on the local hard
drive can automatically be copied into the module's assets folder.

Starting with SwordSearcher 7.1, images pasted into the user editor are automatically
copied to the assets folder. These tools can be used to update older user modules.

Rebuild

The Rebuild Module function completely rebuilds the module data file. This process is
almost never necessary but it can be useful for one of the following purposes:

· If certain text patterns are being incorrectly interpreted as verse links across
multiple entries, you can use the configure verse reference recognition option
rebuild the entries, which re-scans each one for verse links. This is equivalent to
using the Configure Verse Reference Recognition option on the editor's File menu
and re-saving each entry.

· Remove Styles and Formatting from Entries can remove styles and formatting from
all of the entries at once. This removes all hard-coded font names, sizes, and
colors, as well as all CSS-based formatting, and can optionally remove table,
heading, list, and other types of formatting from the entries. This is useful if your
module contains a lot of entries pasted in from external sources with inconsistent or
undesirable formatting, and allows users of the module to see the text in the font,
size, and color they have chosen in their preferences. (Using this option will
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permanently remove formatting information from all entries in the module.
It cannot be undone.) You can do this for specific entries by loading them into
the entry editor as you normally would, and selecting Style and Format Cleaner
from the editor's Format menu.

Zip

You can package a copy of this module file into a zip file for easy sharing or as a means
of backup. Zipping the module includes all used Asset folder files (if any).

Zip an editable copy of the module: Good for personal backup use or if you want to share
your module in editable form.

Zip a read-only copy of the module: Use this if you want to share your module but do not
want it to appear as a user-editable module.Warning! If you zip the module in read-
only form, you will not be able to use the zip file to restore an editable copy of
your content.

Restoring from zip files: Simply extract the zipped module files into your Documents

\SwordSearcher User Modules folder.

Details

Provides a detailed report of the module content, including the results of a module file
integrity check, external links and images, missing images, etc.

11.5 Importing Modules from Previous Versions

This version of SwordSearcher supports user modules created in version 5.0 and later. If
you are upgrading from a 5.x version, you do not need to do anything to use your user
modules. Upgrading will automatically retain your user-created content. If you are
upgrading from version 5.0 or later, you can safely skip the rest of this section.

If you have user-created content in a much older version of SwordSearcher (3.x or 4.x),
you can import it for use in this version of SwordSearcher.

When importing, SwordSearcher simply reads your old file, then creates a new user
module in the SwordSearcher user module storage folder. Your old file is not altered or
erased, and can still be used by the older version of SwordSearcher. The new file,
however, will not be backwards-compatible with previous versions.

If you are manually restoring user modules from another source such as an external hard
drive or a backup, be sure to put them in your Documents\SwordSearcher User Modules

folder. Do not place user modules under the Program Files folder on your hard drive;
they cannot be edited if they are in that location.

Importing SwordSearcher 4.x User Modules

SwordSearcher 4 user Books and Commentaries can be imported. Select Import
SwordSearcher 4.x User Module from the User menu. Choose your user module file when
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prompted to begin importing. If you installed SwordSearcher 4 in the default installation
location, SwordSearcher should be able to locate your user folder. Otherwise, you will
need to manually locate your SwordSearcher 4\User folder to choose your user module.

Repeat this process for each user module you need to import.

Importing SwordSearcher 3.x Note Sets

SwordSearcher 3 user Note Sets can be imported as SwordSearcher commentary
modules. Select Import SwordSearcher 3.x Note Set from the User menu. Choose your
user module file when prompted to begin importing. If you installed SwordSearcher 3 in
the default installation location, SwordSearcher should be able to locate it. Otherwise,
you will need to manually locate your SwordSearcher 3 folder.

Repeat this process for each note set you need to import.

11.6 Building SwordSearcher Modules with Forge

For most users, SwordSearcher's built-in user module features  are
more than enough for creating content in SwordSearcher.  However, authors, publishers,
and power users can take module creation for SwordSearcher to the next level with 
Forge, an external module building tool.

Forge For SwordSearcher is a utility that authors, publishers, and power users can use to
create SwordSearcher library modules from source files. If you're interested, please see
the Forge for SwordSearcher website.

What Forge Does:

Forge takes a source file containing specially formatted text and builds SwordSearcher
commentary, book, or Bible modules. Forge can compile read-only or user-editable
modules.

There are no licensing fees to use Forge to publish your text in SwordSearcher format,
and Forge is a completely free utility.

See the Forge for SwordSearcher website for complete details and to download Forge.
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12 Preferences (Options and Settings)

The Preferences Dialog is where many of SwordSearcher's settings can be changed to
suit your personal tastes, such as fonts, colors, etc.

To access the Preferences Dialog, select Preferences from the File menu.

Opening the Preferences Dialog

The Preferences Dialog has several pages:

Fonts and Colors
Library Tabs Appearance
Visible Library Tabs
Bible Margin Links
Verse Widgets
Text Display Options
Misc. Options
Layout Options
Sync Options
StudyClick Options
Bible Book Abbreviations
Module File Locations
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Saving and Loading Settings

Select the Save, Load, or Restore Settings option on the File menu to save or load
settings to a portable file. The settings file can be used on another computer or as a
backup to load your preferences such as Module Sets, Fonts and Colors, custom Bible
book abbreviations, etc. Also, SwordSearcher keeps a history of your settings as backups
in case you accidentally delete something important such as a Module Set.

12.1 Fonts and Colors

Select the File menu and click Preferences. Select the Fonts and Colors page.

Default text settings controls the font and colors used to display the text in Bible,
Verse List, Book, and Commentary panels. The Search Highlight color is used to highlight
the "found" words when you do a search, or the verse links in an entry when you are
using the Verse Guide. You can click the Set individual panel properties link to adjust
fonts and colors for individual panels (Bible, Book, Commentary, and Verse List) if
desired. Underline links can be turned off if you do not want links to be underlined.

Bible margin and Strong's links controls the colors used for the various links in the
Bible panel margin area. Strong's Links are used in the KJVSL  Bible module. The
Margin Font Size setting is for the Bible panel margin area, and is proportional to the
default text size setting. The Highlight Active Verse color is used to highlight the active
verse in the Bible panel, and can be disabled.

Pop-up verse text and tooltips controls the font and colors used in the "flyover" pop-
up displays for control hints and verse links. (When you hold your mouse over a verse
link, these are the settings used to pop up the verse text.)

Zooming Tip:
You can temporarily zoom in and out on a text panel by holding down the CTRL
button and rolling the mouse wheel over the panel text. See Zooming .

Fonts for Treeviews and the Module Selection Tool

You can customize the font used to display text in the Module Selection Tool, and
"Treeview" lists like the Topic and Verse Guide. Click the Set individual panel properties
link and configure the Treeviews and Module Selector Tool section.

12.2 Library Tabs Appearance

Select the File menu and click Preferences. Select the Library Tabs Appearance page.

Library Tabs are the tabs used to switch between the various library modules (Bibles,
Books, Commentaries).

Library tab font settings controls the font and color used for the "abbreviations" (such
as KJV or Easton) that appear on the resource tabs.

Library tab appearance controls the style of the tab.

Shape controls how the borders of the tabs appear. Choose a shape that is most visually
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appealing to you.

User Modules: Show Pen Icon: when checked, tabs for user-editable modules (such as
your personal commentary module) will include a "pen" icon making it easier to identify
your personal modules in the Book and Commentary panels.

Alignment controls the horizontal configuration of the tabs. Selecting Single Row makes
tabs appear on a single row and adds buttons for scrolling the tabs left and right, and a
drop-down button for selecting the tabs from a menu. This option is especially useful if
you have installed dozens of third-party SwordSearcher modules and want your tabs to
occupy less space on screen.

Tab Color controls the background color of the tabs:
· The Active tab is the currently selected library resource in the panel.
· Inactive Tabs are the other tabs available, but not currently selected.
· Inactive tabs with corresponding entries are tabs for library modules that have an entry

with the same title. This color is used to "highlight" tabs with similar information. See
the help topics on Books  and Commentaries  panels for details.

The sample area gives you a preview of how your settings will appear.

12.3 Visible Library Tabs

Select the File menu and click Preferences. Select the Visible Library Tabs page.

(You can also use the Tabs menu or the Layout and Tabs toolbar to access this
preferences page.)

Here you can select which library resource tabs you want to be visible.  By default (when
SwordSearcher is installed), most tabs are visible.  If you are uninterested in certain
modules, such as non-English Bible texts, you can deselect them from the list and their
tabs will be hidden, saving screen space and reducing clutter.

Note that these selections only affect which tabs are shown on your screen.  It does not
remove modules.  You can still access modules with hidden tabs on the program menus
(Bibles, Books, Commentaries) and within the program (margin links, Topic and Verse
Guides, etc).  If a library resource is to be displayed that has a hidden tab, the tab is
"unhidden" at that point.

You must have at least one visible tab in each category, and the KJV tab cannot be
hidden.

See Managing Library Tabs  for more information. The Module Selection Tool  can
also be used to toggle tab visibility.

Using Module Sets to control Visible Tabs

The SwordSearcher Module Sets system can be used to quickly switch between different
preferred groups of visible library tabs. See the section on Module Sets  for more
information.
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12.4 Bible Margin Links

Select the File menu and click Preferences. Select the Bible Margin Links page.

Here you may select which library modules are included in the margin area of the Bible
panel . The purpose of this preference is to reduce "clutter" in the displays by  only
showing links you are interested in.

Simply uncheck any library items you are not interested in having linked in the Bible
margin area, and check items you do want to have linked.

Note that you can still access all of these modules with the menus and tabs throughout
the program, as well as still being able to use them in the Topic and Verse Guides. This
preference only limits which modules are included in linking in the Verse List  and Bible
panels . Finally, the display of different kinds of links can be completely suppressed
with the toggles on the Bible and Verse List toolbars.

Using Module Sets to control Bible Margin Links

The SwordSearcher Module Sets system can be used to quickly switch between different
preferred groups of Bible margin links. See the section on Module Sets  for more
information.

12.5 Verse Widgets

Select the File menu and click Preferences. Select the Verse Widgets page.

Verse Widgets are icons which appear in the Bible  and Verse List  panels under each
verse reference. Verse widgets do not appear in paragraph mode.

Each widget can be included or excluded based on your preference. Check the items you
want to be included in the Bible and Verse List panels.

Action Widgets: These widgets give one-click access to verse-related functions.

 Set active verse and perform "Go To Verse" actions. Clicking this widget sets the
associated verse as the currently "active" verse and performs the actions you have
selected on the Sync Options  Preferences page under When Go To Verse is Set.

 Topic and Verse Guide. Clicking this widget opens the Topic and Verse Guide  with
the associated verse filled in.

 Find Related Verses. Clicking this widget opens the Find Related Verses  search tool
for the associated verse.

 Copy Verse(s). Clicking this widget copies the associated verse to the clipboard using
your verse formatting options . Shift+Clicking the widget opens a menu for copying a
range of verses starting with the associated verse. See Copying Verses to the Clipboard

.
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 Play Bible audio. See Bible Audio Support .

Favorite Commentaries: A commentary widget is similar to a commentary link in the
Bible margin. However, commentary widgets are shown whether or not there is a
commentary entry for the associated verse. (If there is no commentary entry for the
verse, the widget appears faded.) If the commentary is user-editable, and there is no
entry for the verse, clicking the widget will open the user editor. Also, Shift+Clicking a
user-editable commentary widget opens the editor. You can include up to three
commentary widgets in the Bible panel. You can choose the form of each favorite
commentary icon.

Widget Size: You can control the size of verse widgets here. Select Based on Font to
have the verse widgets scale along with the size of the font used in the Bible panel.
Select Small, Medium, or Large to fix the verse widgets to a particular size.

You can control the color of verse widgets on the Fonts and Colors  page.

Note: Verse Widgets are displayed using the Webdings and Wingdings fonts included on all standard Windows
installations. If any of the Verse Widgets appear as random characters instead of the icons seen above, it may
be necessary to install these fonts, although they should be included by default on any Windows computer.

12.6 Text Display Options

Select the File menu and click Preferences. Select the Text Display Options page.

Verse Hyperlinking Style controls how verse links in the Book  and Commentary
Panels  will appear and function.

Multiple: A list of references will all be one link. Clicking on the verse link will open all
of the references in a Verse List panel . Holding the mouse pointer over the link will
pop up a display of all the linked verses. This option adds a function to the right-click
popup menus of the Book and Commentary panels which sets the Bible panel to one
of the verses in the link.

Individual (recommended): A list of references will be individual verse links.
Clicking on a verse link will move the Bible panel  to the referenced verse. Holding
the mouse pointer over a link will pop up a display of that verse (or range of verses). 
This option is highly recommended and works well with Context Preview pop-ups
(see Misc. Options).

Note that in either case, the right-click popup menus of the Book and Commentary
panels allow you to load all of the referenced verses in a Verse List panel.

This setting will not always affect display of verse links in user modules or third-party
modules. Those modules can contain "hard links" that ignore your chosen Verse
Hyperlinking Style preference.

When SwordSearcher Starts, set Bible panel to... controls what verse the Bible
panel will be set to when SwordSearcher is first started. Last Viewed Passage will
remember what passage you were viewing when you previously closed it and reopen at
that verse. Daily Proverb will open with the Bible panel set to the current proverb. See
Daily Proverb .
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Additional Bible Panel Settings:

Chapter links: Here you may select which (if any) "chapter links" are included in the
Bible panel text area.  These links are redundant because of the Next/Previous
Chapter buttons included on the Bible panel toolbar, but some users will prefer
having them appear in the text area.

Newline Every Verse in Paragraph Mode: causes each verse to start on a new line
when in paragraph mode.

Hide Paragraph Markers: When selected, the pilcrow (¶) used to denote new
paragraphs in Bible text will not be shown.

Show Strong's Numbers and Lexicon Words: Here you may choose how Strong's
links appear in the KJVSL  Bible display. When checked, Strong's links are shown as
lexicon words.  Otherwise, they are shown as Strong's numbers.

Color Words of Christ: The KJV Bible module supports special coloring of words
attributed to Jesus Christ (in the New Testament), also known as "words of Christ in
red" (although SwordSearcher lets you use any color, not just the default red).
Checking the Color words of Christ option will display the words of Christ in the color
selected. Selecting the Bold item will additionally make words of Christ in bold font,
which is helpful due to how some monitors display red text. Only certain modules
support this feature.

Use bold-type for user-editable resource links in the Bible margin helps
indicate which commentaries and book are editable by showing them in bold type.

Bible column spacing: Increase or decreases the amount of white space used in the
Bible panel (non-paragraph mode).

Display of Italicization in Bible Text configures how italic text in some Bible modules
(such as the KJV) is displayed. Normal displays the text as you would expect from a
printed Bible; that is, italicized. Bracketed replaces the italic formatting with [brackets].
None removes all italic formatting from the text. Note that all settings still retain the
italicized text -- this setting only affects how it is formatted for display.

The purpose of this function is to aid reading for users who are accustomed to the
contemporary usage of italic formatting to indicate emphasis. In Bible translation,
italicized text is used to indicate supplied words necessary for translation. For users who
can not read italic text without inferring emphasis, this option gives a solution.

Verse List Defaults controls the initial margin area configuration when a new Verse List
panel  is opened. By default, no margin links are shown in Verse List panels. You may
also select a default comparison Bible text.

12.7 Misc. Options

Select the File menu and click Preferences. Select the Misc. Options page.

Search Bible Default determines which Bible version is set for searching in the Search
Bible Dialog when it is opened. Select Last Searched Bible Version to have the dialog set
to search the last Bible version you performed a search on. Select Active Bible Version to
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have the dialog set to search whichever Bible version is currently active in the Bible
panel. This setting has no effect on the Search toolbar , which always uses the active
Bible version in the Bible panel .

You can still change the search version in the Search Bible Dialog once it opens. This
setting only defines what version it will initially be set to.

Checking for Updates controls how often (and if) SwordSearcher will offer to check for
updates. 

Pop-up verse text:

When Use context preview in Book and Commentary panels for links with less than
five verses is toggled on, pop-up verse text will include a context preview up to a
range of five verses. This setting applies to the Book and Commentary panels, as well
as the Scan Text for Verse References tool, but is ignored if the verse hyperlink
contains multiple verse ranges (set in Text Display Options ). Note that the context
preview is always shown for verse tag links in Verse List panels.

Example of pop-up verse text with context preview.

Example of pop-up verse text without context preview.

Bible module for pop-up verse text controls the Bible text used to display pop-up
verse text. The default setting is "Use active module in Bible panel." You may select a
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module to always use regardless of the active Bible module.

Search Boxes and Toolbar

When Clear History... is toggled on, SwordSearcher will not save history lists between
sessions for Bible searches, Full Library searches, etc. Essentially, any of the entry
boxes that offer a pull-down history list of previously entered text will be erased when
you close SwordSearcher.

Disable Automatically show suggestions menu in Go To Verse and Search toolbar if
you do not want the suggestion menu to appear as soon as you start typing in the 
main toolbar search box .

Advanced Clipboard Settings

When Use system-wide hotkey for auto verse copy+paste is toggled on, the Ctrl+Alt
+V hotkey will work outside of SwordSearcher to automatically paste verses into
other applications, as long as SwordSearcher is running in the background.  See 
Automatically pasting verses into another application  for details.

The option When copying a reference list from a Verse List panel, put the book tag on
each new chapter reference is used when using the Copy Verses References option in
Verse List panels. For example, if you do a search for "love," the first three results are
in Genesis, and by default, the reference list would be copied with each chapter
appearing thus: "Ge 27:4; Ge 29:20,32;..." If you disable this option, the first three
references would be consolidated like this: "Ge 27:4; 29:20,32;..." It is recommended
that this be left on the default (enabled) setting for improved readability. 

When Use plain-text clipboard copy with marked text in displays is toggled on, text
copied to the clipboard by marking with the mouse will always be in plain format. Use
this to prevent formatting styles from being inserted with the text when you paste
into a word processing document. This can also solve compatibility issues with some
programs that do not properly handle HTML clipboard objects.

Enhancements for Touch Input and Visual Impairment

These options are primarily intended to improve the user interface when using touch
input monitors or tablet/slate PCs. They may also be useful to improve the experience
for users with vision problems.

Increase line spacing in panel text adds space between lines of text in the Bible,
Verse List, Book, and Commentary panels. (This makes tapping verse links with your
finger easier).

Increase size of buttons and other controls adds margin inside of buttons and tree
view items (Topic and Verse Guides), making the buttons larger without increasing
the font size. Changes to this option will require a restart of SwordSearcher to take
effect. This option is disabled if your system is set to high DPI (large fonts).

Temporarily use touch-size splitters can also be selected on the main View menu and
is used to make it possible to resize panels with finger input, without a mouse or
stylus.
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12.8 Layout Options

Select the File menu and click Preferences. Select the Layout Options page.

Re-use verse panels:

When a Bible search is performed, a Verse List panel  is created to display the
results. With Re-use Verse Lists selected, a single Verse List panel will be used and
replaced each time a new verse list is created. When this option is not selected, a
new panel will be created for each Verse List, allowing you to view multiple search
results at once.

This option also effects the Load All Referenced Verses functions of the Book and
Commentary panels.

Re-use library search result panels:

When a library search is performed (either with the Full Library Search function, or
the Book or Commentary Quick Search functions), a new Library Search Results panel

 is created to display the results. With Re-use library search result panels selected,
a single results panel will be used and replaced each time a new library search is
performed. When this option is not selected, a new results panel will be created for
each search, allowing you to view multiple library search results at once.

Automatically dock cloned panels:

When a panel is cloned, the clone is added to layout docking automatically. When this
option is not selected, clone panels are created floating (undocked). See Clone Panels

.

Include main window and toolbar positions in custom layouts:

When checked, the position and size of the main window, as well as the configuration
of the main toolbar, is included when you save a custom layout. See Customizing the
Layout .

Allow "auto-hide" feature with custom layout:

This is a "power user" feature and enabling it is not recommended for most users.
You should read and understand Customizing the Layout  and Auto Hide  before
using auto-hide.

12.9 Sync Options

Select the File menu and click Preferences. Select the Sync Options page.

When "Go To Verse" is Set... When a verse or passage is entered in the Go To Verse
and Search toolbar  in the main window, the Bible panel is set to the specified verse.
Select additional actions that should be performed when you enter a verse in the toolbar.
 These actions are also performed when you click the "set active verse" verse widget .

Double-Clicking a Word in the Bible or Verse List Panel... Select what action to take
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when you double-click a word in a Bible or Verse List (Bible search results) panel. By
default, double-clicking a word in the Bible or Verse List panel opens the Topic and Verse
Guide  with the word.  Other options are available here.

Double-clicking a verse reference tag in the Bible panel performs "Go To Verse"
actions. With this option selected, you can double-click a verse tag in the Bible panel
(such as Ge 1:1) to perform whatever actions you have selected for When "Go To Verse"
is Set.

Also, if you also select But open the Topic Guide Dialog instead of a Verse Guide
Panel, double-clicking a verse tag in the Bible panel will open the Topic Guide dialog
instead of a Verse Guide panel. Only use this if you prefer the "floating" Topic Guide
dialog  box instead of the normal Verse Guide panel .

Double-clicking a word in the Book or Commentary panels opens the Topic
Guide. With this option selected, double-clicking a word in the Book or Commentary
panel opens the Topic Guide  with that word entered.

12.10 StudyClick Options

Select the File menu and click Preferences. Select the StudyClick Options page.

These options are for configuring how StudyClick  works.

There are a lot of options to choose from here. Generally, the default options described in
the StudyClick section  should suit most study flows well and it won't be necessary to
change these. Power users will enjoy being able to configure these options.

Under Bible and Verse List Panels you may configure what happens when you use
StudyClick in Bible and Verse List panels. Under Book and Commentary Panels you
may configure what happens when you use StudyClick in Book and Commentary panels.

For example, you can configure Bible panels to open the Webster 1828 dictionary when
you Ctrl+Click a word in the Bible, and the Book and Commentary panels to open the
Topic Guide when you Ctrl+Click a word.

When I hold CTRL and click a word... Choose what happens when you Ctrl+Click a word.
This is your primary action.

When I hold CTRL+ALT and click a word... Choose what happens when you additionally
hold down ALT and click a word.  This is your secondary action.

StudyClick actions you may use are:

· Open the Topic Guide
Opens the Topic Guide and pre-fills the click word into the text box for lookup.

· Search the Bible (immediate):
Search the Bible for the word without opening the search dialog. Also shows a
preview popup as you move the mouse pointer over the words showing the first and
last occurrence of the word in the Bible.

· Search the Bible (with options):
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Same as above, but opens the search dialog so you can modify the search first.

· Open the closest matching entry in Webster's 1828 Dictionary:
Also shows a preview popup with the definition as you move the mouse pointer
over words.

· Open closest matching entry in current book:
Works best when a dictionary is your active book. Also shows a pre-view popup
with the definition as you move the mouse pointer over words.

· Open closest matching entry in the book I select for lookup: (see below) Choose
your favorite dictionary. Also shows a preview popup with the definition as you
move the mouse pointer over words.

· Full Library Search (immediate):
Search your entire library for the word without opening the search dialog.

· Full Library Search (with options):
Same as above, but opens the search dialog so you can modify the search first.

Use this book module for lookup: for StudyClick actions that involve a lookup, you can
specify which book module to use, such as your favorite dictionary.

For Bible searches started with StudyClick, you can choose to always use a specific
Bible module (regardless of which Bible module is active) by checking When I use
StudyClick to start a Bible search, always use this Bible module... and choose which one
you want to be used.

A special StudyClick action for Bible verse links can be selected under When I hold
CTRL and click a verse link:

· Open the verse in a Clone Bible Panel:
See Clone Panels . This allows you to open a "new Bible panel" to avoid losing
your place in the main Bible panel, and still read the full chapter context of a verse.

· Set the verse in the Verse Guide Panel:
See Verse Guide Panel .

· Open the verse in the Topic Guide:
See Topic and Verse Guide .

· Perform "Go To Verse" actions:
This is like typing the verse reference into the Go To Verse and Search box on the
main toolbar. See Sync Options .

· Open the Find Related Verses  Tool.

· Open the Passage Analysis  Tool.

This option also works in the non-linked Bible panel verse tags as you hold down the
CTRL key and move the mouse pointer over the verse tag.
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12.11 Bible Book Abbreviations

Select the File menu and click Preferences. Select the Bible Book Abbreviations page.

SwordSearcher has a standardized list of Bible book abbreviations , but you can
customize these to suit your own needs. For example, you may wish to change the
abbreviation for Genesis from Ge to Gen., which you can do here.

Simply double-click an abbreviation in the list to change the abbreviation. Abbreviations
you specify must use at least two characters, may not contain spaces, and must be
recognizable by SwordSearcher as the book name you are setting. You may add an
optional period to the end of the abbreviation.

You can click Reset All to Defaults to go back to the standardized list.

12.12 Module File Locations

Select the File menu and click Preferences. Select the Module File Locations page.

See also User Module Storage and Sharing .

You may add additional folder paths for SwordSearcher to use for loading library modules
and for user-created module storage.

By default, SwordSearcher creates a SwordSearcher User Modules folder in your Windows
user Documents folder. For most users this is perfectly adequate and there should
be no need to change these settings.  This is the location SwordSearcher places
newly created user books and commentaries and is where the Bible highlighting data is
stored.

Advanced users can add additional locations for SwordSearcher to look for modules at
startup and even disable the creation of the default user module folder, and can move
the Bible highlighting data to another location.

For example, you may wish to use a Windows OneDrive folder instead, so that you can
synchronize your user modules or Bible highlighting data between multiple computers.
Or, you might want to put your user modules on a removable flash drive.

Files must be available offline. If you choose a OneDrive folder in Windows, be sure to
make the folder storing your user modules available offline. This is easy to do: go to the
folder in Explorer, right-click it, and choose Make Available Offline. You will need to do
this on each PC where you want modules synchronized. If you don't do this,
SwordSearcher may not have access to the files when it needs them. (As Microsoft
makes changes to the OneDrive system, these details may change.)

Be careful when adding non-fixed drive folders. If you use a removable device such
as a thumb drive or removable hard drive, never remove the device when SwordSearcher
is running. Also, adding non-local folders, such as a local area network shared folder, can
adversely impact SwordSearcher startup time and greatly slow down SwordSearcher,
especially if you are connected via WiFi or a wired network with less than gigabit speeds.
Doing so is not recommended.

Never edit a user module from a cloud storage location when it could be open on
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more than one computer.  While you can use cloud file mirroring services like
OneDrive to store user modules, you should never try to edit a module while it could be
open on another PC at the same time.  If you do, the cloud service may create duplicate
module files that can not be reconciled later. There is no way to merge conflicting
changes between duplicated module files. Do not do this!

SwordSearcher does not look into "subfolders" of the folders you select, so be sure to
select folders that contain modules, not folders of folders.

When there are multiple module file locations added, the Create New Commentary and
Create New Book functions will have an additional option to select which folder the
module should be created in.
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13 Panel Layout

Introduction to SwordSearcher's Layout

SwordSearcher's study layout is based on the idea that there are four primary types of
"documents" used during study:

· The Bible (first and foremost!)
· Books (including dictionaries and topical references)
· Commentaries
· Search Results (such as verses found in a Bible search or a Verse Guide)

These four types of resources are separated into four "panels." The Bible panel , the
Books and Dictionaries panel , the Commentaries panel , and the Search Results
panel . (The Search Result panel can itself be separated into more panels during layout
customization, described later.)

Most users will probably choose to use the default "Bible on Left" layout, and some users
will switch to one of the other pre-set layouts available. However, SwordSearcher allows
you to completely customize the positions and sizes of these panels on your screen if you
so desire, even to the point of undocking a panel completely and setting it outside of the
main window. You can save as many of these "custom layouts" as you need.

Important Note

Most users will have all the control they need with the pre-set layout selections .

It is not necessary to familiarize yourself with SwordSearcher's advanced layout
features! Most users will find the default settings suitable, and in fact, layout
customization is disabled by default. These features are provided for "power users" who
really want to get into customizing the software they use.

Layout Topics

Using the pre-set layout styles
Resizing the panels
Advanced: Customizing the layout
Even more advanced: Auto Hide

See also Clone Panels .

13.1 Using the pre-set layout styles

There are four "pre-set" layout styles in SwordSearcher. Choose a layout with the View
menu's Set Layout submenu, or with the layout toolbar .

The Restore Layout function (keyboard shortcut: Alt+A) applies the last selected layout
style. This can be handy if a resize or customization operation renders the layout
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undesirable in some way, as it will quickly return the layout to the selected style.

Selecting a layout style with the Layout toolbar

Below is an explanation of each layout style, though it is probably easier to simply try
them out in SwordSearcher.

Bible on Left (Default Layout)

The Bible panel is on the top-left of the main window. The Search Results panel is below
the Bible panel. The Books and Dictionaries panel is to the right of the Bible panel, and
the Commentaries panel is below that.

SwordSearcher Classic

This style emulates the layout of SwordSearcher 4. The Search Results panel has priority
as the top-left panel, with the Bible panel on the top-right. The Books panel is below the
Search Results panel, and the Commentaries panel is below the Bible panel.

Bible on Left; Results on Right; Books and Commentaries Below
Results

In this layout style, the Bible panel occupies the entire left half of the main window. The
Search Results panel is on the top-right. The Book and Dictionaries panel, and the
Commentaries panel, are "tabbed" and occupy the bottom-right of the main window.
With this style, the Books and the Commentaries panels cannot be viewed
simultaneously (you must click the appropriate tab to bring the panel forward). However,
this layout style has the advantage of giving the majority of the screen space to Bible
text.

Single Panel View

A layout style designed for very small displays. Each panel is tabbed along the bottom of
the screen.
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13.2 Resizing, Maximizing, and Hiding the panels

Resizing Panels

To change the size of a panel, click and drag the divider between two panels, and release
the mouse button where you want the new division to be:

Resizing panels

Use the Restore Layout  function to reset the sizes of the panels to the last pre-set
layout you selected.

Maximizing and Hiding Panels

The Maximize and Hide buttons appear on a panel's caption bar:

Maximize and Hide panel buttons

The Maximize button makes the panel fill the entire main window and hides all other
panels. The Hide button closes the panel, hiding it from view. You can toggle a hidden
panel back to visible on the View menu or with the panel's associated Show shortcut key.
When a panel is maximized, the maximize button changes to a restore button, and
clicking it will return the panels to the previous state.

Note: Closing a Search Results panel is permanent, because once you are finished
viewing search results, there is no need to keep the data in memory. The search panel
will open again the next time you do a search.

The View menu has commands for hiding/showing/maximizing panels, and there are also
associated keyboard shortcuts.

13.3 Advanced: Customizing the layout

If one of the pre-set layout styles  does not suit your needs, SwordSearcher provides
you with the ability to completely customize the location of the various panels.

This is considered an advanced feature, and as such, it is not necessary for most users to
become familiar with it.
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At any time, you can use the Restore Layout  function to reset the panel layout to the
last layout style used or saved.

Enabling Layout Customization

Layout customization is disabled by default. To enable layout customization, select
the Enable Layout Customization option on the View menu.

Enabling layout customization

Once enabled, you can begin undocking the various panels and changing their location.

The Docking System

SwordSearcher has an advanced docking system that allows you to "grip" the panel
captions and tabs, then drag them around to place them in the desired location. You can
even completely undock a panel and leave it "floating" over or off of the main window.

Undocked panels are great with multiple monitor setups. If you have more than one
monitor, you can undock panels and move them to another monitor completely.

To undock and float a panel, double-click the caption bar of the panel:
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Undock and float a panel

The panel will now be a free-floating window on your desktop, which can be moved by
click-dragging the title bar:

Floating panel - the Bible panel is undocked from the main window.

Double-clicking the title bar will "re-dock" the panel to its previous location.

To dock a panel, click-drag its caption bar (or title bar, if it is floating). While you do so,
docking targets will appear, showing you where and how you can dock the panel.
Release the mouse button directly over the desired target:
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Docking targets - drag to the desired target and release the mouse button.

Panels are docked relative to, or inside of, panels already on the main window. The
center target docks the panel inside of the target panel, making both panels "tabbed."
The outer targets dock the panel to the indicated side of the target panel.

If a panel is "tabbed," dragging its caption bar or tab will remove it from the tabbed
collection and dock or float it elsewhere.

The easiest way to learn SwordSearcher's docking system is to experiment. You can
always reset the layout with the Restore Layout function.

Keyboard commands for use during docking: While you are dragging a panel, you
can press Esc to cancel the docking operation, leaving the layout unchanged. You can
hold the Ctrl button to prevent docking, so you can make the panel float over any
location on the screen without docking targets forcing the panel to dock.

Saving custom layouts

Once you have organized and sized the panels to create a layout you are satisfied with,
you can save your layout in case you need to restore it again later. Also, some users will
find it beneficial to create different layouts for different forms of study.  SwordSearcher
allows you to save and restore as many custom layouts as you wish to create.

To save the current layout as it appears on-screen, select Save Current Layout on the
View menu or the layout toolbar  drop-down menu. Custom layouts appear at the
bottom of the Set Layout menu (on the View menu and on the layout toolbar drop-down
menu).  Once you have saved, or loaded, a custom layout, it becomes the "default
layout," so that using the Restore Layout function (Alt+A) will reset the layout to your
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chosen configuration.

You can delete custom layouts with the Delete Custom Layout function on the View menu
or the layout toolbar drop-down menu.

Custom layout tip: When creating a custom layout to save, it is best to do so with a
single search result panel open. This way you can be sure that the layout system knows
where you want search result panels to appear. You can also move the Verse Guide Panel
independently of other search result panels, and the layout system will display it
separately in your custom layout.

13.4 Even more advanced: Auto Hide

SwordSearcher's advanced docking system supports an auto hide feature. This feature is
not recommended for most users, as it can easily make your user interface confusing if
you are not familiar with it. It is disabled by default.

Auto Hide is a user interface feature common to programming environments which allows
unused panels to be "unpinned" and hidden to an edge of the main window, freeing up
space for the other panels.

To use auto hide, you must have layout customization enabled on the View menu. Also,
you need to enable auto hide on the Layout Options page of Preferences .

To enable auto hide for a panel, use the "pin" button on the caption bar:

The "pin" button on a caption bar toggles auto hide for the panel

When a panel "auto hides," a caption tab for the hidden panel will appear on an edge of
the main window.
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An auto-hidden panel reduces to a tab on an edge of the
main window

Passing your mouse cursor over the tab will display the panel. Moving the mouse cursor
away from the panel will hide it again. Clicking on anything in the panel while it is
showing sets the focus to the panel and will prevent it from hiding again until focus is set
to a different panel.

Click the pin button of an auto-hidden panel, when it displays, to disable auto hide for
that panel.

A panel caption will only show a pin button when auto hide is enabled in preferences,
and Enable Layout Customization is selected on the View menu, and the panel does not
have other panels docked to it. Sometimes it may be necessary to alter the docking
layout to auto hide a specific panel.
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14 Clone Panels

A Clone Panel is a special type of Bible , Book , or Commentary  panel created
when you select the Clone Panel option from the respective panel menus.

A Clone Panel is essentially a "snapshot" or copy of the content of one of the panels
which never changes.  This makes it easy to hold your place in a Bible, Book, or
Commentary while still being able to move around in the software, clicking links, etc.

For example: begin a study on John chapter three by setting the Bible panel to John 3. 
Next, click the main Bible menu and Clone Bible Panel Content. (You can also select
Clone Panel from the Bible panel right-click pop-up menu.)

Sample Bible menu and Bible panel

A new panel is created containing the text of John 3:
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Sample clone panel

Now you can move the Bible panel to other chapters but still have John 3 (and margin
links) visible on-screen.  A clone panel has a right-click pop-up menu similar to the
original panel's menu.  A clone panel functions substantially the same as its original
panel, except that it will not navigate away from its current text.

You can create as many clone panels of any type as you need.  When you are finished
with the passage or entry, simply close the clone panel.  The View menu has options for
selecting among your clone panels (if any) and you can close all clone panels at once by
pressing Ctrl+Alt+F9.

In Book and Commentary panels, you can Ctrl+Click a verse link to open a clone Bible
panel at the verse reference. (See StudyClick settings .)

By default, when you create a clone panel it is automatically docked to the search
results.  If you prefer to have clone panels created floating instead, go to File >
Preferences > Layout Options and un-check Automatically dock cloned panels. This way,
a clone panel appears just above its original panel, and you can move or dock it as you
see fit.  This is very handy especially if you have multiple monitors.  Experiment to see
what works best for your study flow.
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15 Bible Audio Support

SwordSearcher supports integration of an audio Bible. With Bible audio support, you can
play narrations of the Bible with familiar audio controls in the Bible panel.

SwordSearcher does not include an audio Bible, but instead, supports "linking" MP3 Bible
file sets available from various publishers. To enable Bible audio in SwordSearcher, you
must obtain the audio files and link them in SwordSearcher with the easy-to-use
Configure Bible Audio window.

StudyLamp Software LLC does not publish an audio Bible. Audio files are not included with SwordSearcher.
SwordSearcher supports the integrated playback of audio files on the user's computer only.

Recommended audio Bible for use with SwordSearcher

Scourby Audio Bible: King James
Version.
Read by Alexander Scourby™.
MP3 files on DVD-ROM.

Published by Hendrickson
Publishers.
ISBN-10: 1598563599
ISBN-13: 978-1598563597

Available from Amazon.com.

For the best audio integration, it is recommended that you purchase the Scourby King
James Version Audio Bible MP3 CD/DVD set, narrated by Alexander Scourby™, published
by Hendrickson Publishers. Use the link above to purchase from Amazon.com, or find the
product at a local reseller using the exact ISBN-10 or ISBN-13 listed above. (At the time
of this writing, the cost of this audio Bible is less than $16 US.) For the proper
integration with SwordSearcher, it is important to obtain the exact item here.

StudyLamp Software LLC is not affiliated with Hendrickson Publishers or Litchfield Associates. "Alexander
Scourby" is a trademark of Litchfield Associates Ltd.

Why use this specific audio Bible?

SwordSearcher supports verse-level synchronized playback of the Hendrickson KJV MP3
Bible audio files. This means that you can have the Bible panel highlight and scroll
individual verses as the narration plays, and you can play verse lists aloud from a Bible
search.  To achieve the optimal level of integration with SwordSearcher, this audio Bible
is recommended.

What will I need to do?

Once you purchase the MP3 set, you need to copy all of the files from the MP3 DVD to
your computer.  Using Windows Explorer, create a folder on your hard drive and give it a

http://www.amazon.com/gp/product/1598563599/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=1598563599&linkCode=as2&tag=swordsearcher-20&linkId=4YX3T3YPOXVOTGGT
http://www.amazon.com/gp/product/1598563599/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=1598563599&linkCode=as2&tag=swordsearcher-20&linkId=4YX3T3YPOXVOTGGT
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name like "Scourby MP3s" and copy all of the contents from the DVD-ROM to this folder.
Follow the instructions listed below for setting up audio in SwordSearcher.

Note that the Hendrickson Scourby KJV MP3 Audio Bible includes both a DVD-ROM and a collection of CD-
ROMs. It is only necessary to copy the files from the DVD-ROM to your computer. You do not need to do both.

Other audio Bible file sets you can use

See the Integrated Audio Bible Support page on the SwordSearcher web site for current
information.

While we highly recommend the MP3 audio Bible above, SwordSearcher supports several
other MP3 audio Bibles.  In order to link an audio Bible in SwordSearcher, there must be
one file per chapter of the Bible, in MP3, WMA, or WAV format.  The following audio
Bibles have been tested and are known to work in SwordSearcher:

· The AMG Publishers Complete Bible KJV MP3 CD-ROM set, narrated by Alexander
Scourby. Verse-level synchronized playback is supported with this set.

· The AMG Publishers Complete Bible KJV MP3 digital download, narrated by Alexander
Scourby. Verse-level synchronized playback is supported with this set.

· The Listener's Bible narrated by Max McLean (MP3 download). Available from http://
www.listenersbible.com/ . Chapter-based playback only.

· Stephen Johnston's KJV MP3 Bible from Firefighters.org. Chapter-based playback only.

· Full Bible audio downloads from http://www.bible.is . (Verified with the non-
dramatized KJV audio files.) Chapter-based playback only.

The above MP3 Bibles are known to work in SwordSearcher.  Other file sets may also
work, as long as they contain one chapter per file and the file names contain
recognizable scripture references. Because SwordSearcher only plays the audio from the
files, it does not matter what Bible version is used in the audio, and the audio can be
played regardless of which Bible text is active or visible in SwordSearcher.

StudyLamp Software LLC is not affiliated with any of the companies publishing the audio files mentioned
above. 

Setting up Bible audio support

If you have not already done so, copy all of the files for your audio Bible into a folder on
your hard drive. It's okay if this folder contains sub-folders (such as a folder for the Old
Testament and one for the New Testament, or one folder per disc, etc).  If you have
purchased and downloaded an audio Bible from the Internet, the files should already be
on your hard drive, and you just need to locate them. (Please consult the installation
instructions that came with your audio Bible purchase if you do not already have the files
installed.)

In SwordSearcher, on the File menu, select Configure Bible Audio.

http://www.swordsearcher.com/audio-bible.html
http://www.amazon.com/gp/product/0899575951?ie=UTF8&tag=swordsearcher-20&linkCode=as2&camp=1789&creative=390957&creativeASIN=0899575951
http://forums.swordsearcher.com/threads/audio-bible-support-in-swordsearcher-updated-nov-2014.2591/
http://www.listenersbible.com/
http://www.listenersbible.com/
http://www.bible.is
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In the window that appears, click Link Audio Files, and select the folder containing the
MP3, WAV, or WMA files. Again, it is okay if the files are broken up into sub-folders.
Select the folder containing all of the files or sub-folders.  For example, I have copied the
Hendrickson MP3 DVD to my hard drive into a folder called "Hendrickson Scourby DVD"
and choose that folder:
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Sample showing how to link audio files.

Click OK and SwordSearcher will scan the files to integrate them into the Bible panel.

If you are using the Hendrickson or AMG Scourby Audio Bible (as mentioned above),
SwordSearcher will provide verse-level synchronization and playback. If you are using a
different audio file set, you will have chapter-level playback only.  This verse-level
support simply means that you can play back individual verses and have verses
highlighted during audio playback.

Audio options

The Configure Bible Audio dialog offers several options:

Link Audio Files is explained above and can be used at any time to set up audio file links.
 If you ever move the files to a new location or decide to use a different audio Bible, you
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will need to click this to re-link the audio in SwordSearcher.

Verify Audio File Links can be used to make sure all of the audio files are still correctly
linked in SwordSearcher.  If any files have been moved, this will report which ones are
missing.

Remove Audio Links deletes the audio file links in SwordSearcher, as if you had never
configured Bible audio. It does not delete files.

Automatically scroll Bible panel during chapter playback: Causes the Bible text to scroll
as audio is played. If you are using the Hendrickson or AMG MP3 Bible mentioned above,
this scrolling is exactly accurate to the current verse being narrated. If you are using a
different MP3 Bible, the scroll position is estimated but usually quite accurate.

Scroll method: Use verse-by-verse scrolling scrolls to each verse as it is narrated,
keeping it centered in the panel. This option is only available for the Hendrickson  or AMG
Scourby MP3 audio Bibles. Use consistent scrolling slowly scrolls the text throughout the
playback and may be more pleasing for some users. This is the only scrolling method
available if you are not using the Hendrickson or AMG Scourby MP3s.

When chapter playback is complete, automatically play next chapter: if this option is
selected, playback will be continuous through the whole Bible until you stop playback.
When the end of the chapter is reached, the next chapter will be loaded and played
automatically.

Include a play button next to each verse: If you are using the Hendrickson or AMG
Scourby MP3s (see links at the beginning of this section), you can have a "play" button
(which looks like a speaker cone) next to each verse to begin playback at that verse. 
See Verse Widgets .

Highlight verses during playback: Available if you are using the Hendrickson or AMG
Scourby MP3s. The currently narrated verse will be highlighted, and the highlight will
follow along with the playback.

Using Bible audio

Once you have set up Bible audio support, the Bible panel  will add a media control bar
at the bottom:

143

10



SwordSearcher 7168

© 2015 StudyLamp Software LLC

Sample Bible panel showing media control bar

The Play Audio Verse Widget (see Verse Widgets ) only appears if you are using the
Hendrickson or AMG Scourby Audio Bible (which supports individual verse playback).
Clicking this verse widget starts playback at the specific verse and continues through the
chapter.  Shift+Clicking the widget plays back that verse only. Clicking the verse widget
of an actively-playing verse stops playback.

The media control bar (bottom of panel) works like a typical audio player. If you are
using the Hendrickson or AMG Scourby Audio Bible, the skip buttons will move back/
forward one verse.  For other Bible audio file sets, the skip buttons will move 
approximately by verse. Clicking on the playback progress bar will jump to that location
in the audio.

You can use the keyboard Pause button or Ctrl+Space to toggle playback as well.  (The
Pause button is usually located above the Insert key but may not be included on compact
keyboards.)

It does not matter which Bible version you are reading, or from which version your audio
is narrated. The Bible panel will always show the media controls, and they will always
operate, regardless of the active Bible version or the version used in the audio. They also
work when the Bible panel is in compare mode and in paragraph mode.

While audio is playing, all other features of SwordSearcher are fully functional. You can
perform searches, view and edit commentaries and books, etc. Playback is also available
in cloned  Bible panels. Tip: Open a clone Bible panel on the chapter you want to

143
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study. Begin playback in the clone panel.  When you want to stop for a moment to search
out a topic, pause playback and perform your searches or read your cross-references. 
When you're ready to continue listening, resume playback from the cloned Bible panel or
by pressing Ctrl+Space.

The Bible panel right-click pop-up menu also includes playback commands.  If you are
using the Hendrickson or AMG Scourby Audio Bible, these additional commands appear
as follows:

Sample audio playback menu items
from the Bible panel (with verse-level

support)

If you are using a different audio file set (which does not support individual verse
playback), the additional menu commands appear as follows:

Sample audio playback menu items from the Bible
panel (without verse-level support)

The main difference in menu options is that for audio file sets without individual-verse
playback support, SwordSearcher can estimate the position of a verse in the chapter
audio to begin playback at that verse.  Usually, estimated playback will begin a little bit
before the selected verse.  For the best results, the Hendrickson Publishers' Scourby KJV
audio Bible is recommended.

If you are using the Hendrickson or AMG Scourby Audio Bible, Verse List panels  also
include playback controls.  You can play aloud complete verse lists just as you can play
back a chapter of the Bible.
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16 Appendix: Keyboard Shortcuts

SwordSearcher has many keyboard shortcuts to quickly perform functions without using
the mouse. Certain tasks will always require some use of the mouse, but advanced users
who like to stick to the keyboard as much as possible will benefit from the many
keyboard shortcuts provided in SwordSearcher.

Here is a list of the keyboard shortcuts SwordSearcher's main user interface responds to.
This is not a comprehensive list of SwordSearcher's functions, just a list of keyboard
shortcuts for functions that have keyboard shortcuts.

"Edit" commands:

· Ctrl+C: Copy selected text
· F5: Copy verse(s) to clipboard
· F7: Copy all verses from Verse List panel
· Shift+F7: Copy all references from Verse List panel
· F8: Copy all verses from Bible panel
· Ctrl+Alt+V: From another application, such as MS Word, opens the Copy Verses

dialog in SwordSearcher and automatically pastes the selected verse reference.

"Search" commands:

· F2: Search Bible dialog
· F3: Quick Search in active Book
· F4: Quick Search in active Commentary
· Ctrl+F: Search text displayed in focused panel (does not search entire module)
· Alt+T: Open Topic and Verse Guide
· Alt+L: Full Library Search dialog
· Ctrl+F2: Open English-Strong's Indexer
· Shift+Alt+T: Open Library Table of Contents tool
· Alt+F5: Open Scan Text for Verse References tool
· Alt+F2: Search KJV Words of Christ

Bookmarks:

Access bookmarks with Ctrl+#, where # is the number of the bookmark you want to
go to. Press Ctrl+1 for bookmark number 1, or Ctrl+0 for bookmark number 10. Set
bookmarks with Shift+Ctrl+# in the same manner.

"Library Tabs" commands:

· Alt+F11: Show all tabs
· Alt+F12: Show only selected tabs

"View and Layout" commands:

· F9: Close active Search Result panel
· Ctrl+F9: Close all open Search Result panels
· Ctrl+Alt+F9: Close all open Clone panels.
· F10: Show/Hide Bible panel
· F11: Show/Hide Book and Dictionary panel
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· F12: Show/Hide Commentary Panel
· Alt+A: Restore layout and panel sizes
· Shift+F9: Maximize active Search Results panel
· Shift+F10: Maximize Bible panel
· Shift+F11: Maximize Book and Dictionary panel
· Shift+F12: Maximize Commentary panel
· Ctrl+]: Increase text display font sizes
· Ctrl+[: Decrease text display font sizes
· Ctrl++: Increase zoom level
· Ctrl+-: Decrease zoom level
· Ctrl+Alt+0: Reset zoom level to 100%

Bible Panel commands:

· Alt+PgDn: Next chapter
· Alt+PgUp: Previous chapter
· Alt+Down: Next verse (based on "active verse" as shown in Go To Verse toolbar)
· Alt+Up: Previous verse (based on "active verse" as shown in Go To Verse toolbar)
· Alt+F10: Toggle display of margin area
· Ctrl+H: Apply default highlighting to selected text.

Set Keyboard Focus:

· F6 or Alt+G or Shift+F2: Set keyboard focus to Go To Verse and Search toolbar
· Alt+1: Set keyboard focus to Verse List panel
· Alt+2: Set keyboard focus to Bible panel
· Alt+3: Set keyboard focus to Book panel
· Alt+4: Set keyboard focus to Commentary panel

Misc:

· Ctrl+M: Select a module with the Module Selection Tool
· Ctrl+F10: Select Bible module with Module Selection Tool
· Ctrl+F11: Select Book module with Module Selection Tool
· Ctrl+F12: Select Commentary module with Module Selection Tool
· Shift+F5: Display Verse(s) (loads user specified verses into a Verse List panel)
· F1: Open help file
· Shift+Ctrl+F10: Next Bible version tab
· Shift+Ctrl+F11: Next highlighted Book tab
· Shift+Ctrl+F12: Next highlighted Commentary tab
· +/- (while focused on panel with highlighted search results showing): Cycle

through highlighted search results
· Alt+F4: Exit SwordSearcher
· Ctrl+Alt+F4: Exit SwordSearcher without saving layout (used for troubleshooting

purposes)
· Alt+Up/Down: Decrements/Increments active Bible panel verse and performs "Go

To Verse" events.
· Alt+Left/Right: Navigate the back/forward history list in the focused panel.
· Pause/Ctrl+Space: Pause/Resume Bible audio playback, or start Bible panel

chapter playback.

Search Bible dialog: only when Search Bible dialog (F2) is open
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· Alt+M: Manually enter search range.
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17 Appendix: Standard Bible Book Abbreviations

Following are the standardized abbreviations SwordSearcher uses for the books of the Bible. These
are the standard abbreviations, but SwordSearcher understands over 2,000 forms of Book names
and abbreviations. Also, you can customize the abbreviations  if you wish to use your own set.

Old Testament New Testament

Ge Genesis Mt Matthew

Ex Exodus Mr Mark

Le Leviticus Lu Luke

Nu Numbers Joh John

De Deuteronomy Ac Acts

Jos Joshua Ro Romans

Jg Judges 1Co 1 Corinthians

Ru Ruth 2Co 2 Corinthians

1Sa 1 Samuel Ga Galatians

2Sa 2 Samuel Eph Ephesians

1Ki 1 Kings Php Philippians

2Ki 2 Kings Col Colossians

1Ch 1 Chronicles 1Th 1 Thessalonians

2Ch 2 Chronicles 2Th 2 Thessalonians

Ezr Ezra 1Ti 1 Timothy

Ne Nehemiah 2Ti 2 Timothy

Es Esther Tit Titus

Job Job Phm Philemon

Ps Psalms Heb Hebrews

Pr Proverbs Jas James

Ec Ecclesiastes 1Pe 1 Peter

Song Song of Solomon 2Pe 2 Peter

Isa Isaiah 1Jo 1 John

Jer Jeremiah 2Jo 2 John

La Lamentations 3Jo 3 John

Eze Ezekiel Jude Jude

Da Daniel Re Revelation

Ho Hosea

Joe Joel

Am Amos

Ob Obadiah

Jon Jonah

Mic Micah

Na Nahum

Hab Habakkuk

Zep Zephaniah

Hag Haggai

Zec Zechariah

Mal Malachi
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18 Appendix: SwordSearcher URL Protocol

This is an advanced topic and the information here will be useful to only a small portion
of SwordSearcher users.

Starting with version 5.3, SwordSearcher has a standardized URL linking system which
functions anywhere in Windows where URLs are recognized, such as Internet Explorer
(HTML href links), MS Word, explorer bars, etc., and in user-created SwordSearcher
modules. The SwordSearcher URL protocol opens SwordSearcher and performs certain
actions, such as setting the Bible panel to a verse, loading a verse list, performing a
search, and other common tasks. When SwordSearcher 5.3 (or later) is installed, the URL
protocol is registered with Windows automatically.

A SwordSearcher link looks like this:

swordsearcher://bible+kjv/Ge1.1

The following is a complete specification of the SwordSearcher URL format.

URL format:

swordsearcher://[Action](+[ResourceAbbreviation])/[Entry]

Action is required and tells SwordSearcher what you want to do.
+ResourceAbbreviation is usually optional and only applies to some Actions. It tells
SwordSearcher which module, if any, you want the action to be performed with. Finally, 
/Entry is required and is the entry you wish to open or text you wish to search.

An important note about encoding links: It is important to encode special characters in links, like spaces.
A discussion of general URL formatting is beyond the scope of this text. However, the most common
encoding that usually needs to be done is the space character, which should be represented as %20 in a
URL instead of an actual space. Though the space will work properly in SwordSearcher, many other
applications may not properly handle a true space. Also, due to the way Internet Explorer handles
quotation marks (even encoded ones), SwordSearcher recognizes [q] as a double-quote. So, for example,
an html link to a KJV phrase search for "sword of" would be written like this:

<a href="swordsearcher://search+kjv/[q]sword%20of[q]">Search for "sword of"</a>

Here is a list of action types and examples.

BIBLE
ResourceAbbreviation (optional) is the desired Bible module
Entry is the verse reference to set the Bible panel to
Example: swordsearcher://bible+kjv/mt1.1

Example: swordsearcher://bible/mt1.1 

VERSELIST
ResourceAbbreviation (optional) is the desired Bible module
Entry is a string of verse references to be parsed and loaded into the Verse List panel
Example: swordsearcher://verselist+kjv/ge1.1-5;ex1.1;de1.1

Example: swordsearcher://verselist/ge1.1-5;ex1.1;de1.1 

STRONGS
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ResourceAbbreviation ignored
Entry is Strongs number, such as G100 or H100.
Example: swordsearcher://strongs/g100 

BOOK
ResourceAbbreviation (optional) is desire book module. If not specified, active book is
used.
Entry is the desired entry title.
Example: swordsearcher://book+torrey/manna 

CMTY
ResourceAbbreviation (optional) is desired commentary module. If not specified, active
cmty is used.
Entry is the desired verse entry.
Example: swordsearcher://cmty+mhcc/ge1.1 

IMAGE
ResourceAbbreviation is ignored.
Entry is the image path in the SwordSearcher image store.
Example: swordsearcher://image/Easton%20Illustrations/Aceldama.png 

SEARCH
ResourceAbbreviation is module to perform search on.
Entry is the search expression to use.
Example: swordsearcher://search+kjv/love 

TVG
Opens the Topic and Verse Guide.
ResourceAbbreviation ignored
Entry is the text to set in the TVG.
Example: swordsearcher://tvg/love opens the TVG and indexes 'love.'

Example: swordsearcher://tvg/ge1.1 opens the TVG and shows all references to Ge 1:1.

EDIT
(SwordSearcher version 7.2 or later)
Opens an entry in an editable user module for editing. If the entry does not exist, it is
created.
ResourceAbbreviation is the book or commentary module to edit.
Entry is the title of the entry to edit. For books, this is any valid entry title. For
commentaries, this is a verse reference.
Example: swordsearcher://edit+MyTopics/Love opens the MyTopics book module in the

editor for the entry "Love", which is created if it does not exist.
Example: swordsearcher://edit+MyNotes/Ge1.1 opens the MyNotes commentary module

in the editor for the entry on Genesis 1:1, which is created if it does not exist.
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